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1 Product overview

Granular Restore for Microsoft Exchange and SQL (GRE) is a granular data extraction software for offline SQL
databases and Microsoft Exchange Server mailbox stores and Outlook files. The utility provides direct access to
unmounted database tables and mail store contents, displaying file structure and its contents with selective
export functionality. With a search query tool, users are able to export specific queries rather than large tables
or files.

For SQL databases, recovered items can be saved as SQL scripts or exported directly to a live SQL server.

For Microsoft Exchange servers, files can be saved as Personal Storage File (.pst) files, to be opened with
Microsoft Outlook or other compatible email clients, or exported directly into live Exchange Server mailboxes.

The utility makes no changes to the store, preserving it in original unmodified state.
Main features of Granular Restore for Microsoft Exchange and SQL
SQL Database

e Recovers entire tables, objects and object groups

e Recovers data obtained by specific search queries

e Recovers keys, scripts, functions, triggers and procedures

e Recovers default settings, user types and views

e Saves single or multiple points of data as SQL scripts or exports to live SQL database
Microsoft Exchange Server

e Recovers mailboxes, folders, messages and file attachments

e Recovers contents of Public Folder mailboxes

e Recovers email addresses from Active Directory storage

e Recovers notes, contacts, tasks and appointments

e Recovers creation dates for all objects

e Saves selected items to PST files or exports to live Exchange Server mailbox(es)

1.1 Supported Exchange database versions
Granular Restore for Microsoft Exchange and SQL supports the following mail store versions:

2016 CU7, 2016 CU6, 2016 CU5, 2016 CU4, 2016 CU3, 2016 CU2, 2016 CU1, 2016 RTM, 2013 CU17, 2013 CU1S6,
2013 CU15, 2013 CU14, 2013 CU13, 2013 CU12, 2013 CU11, 2013 CU10, 2013CUS9, 2013CU8, 2013CU7,
2013CU6, 2013CUS5, 20135P1, 2013RTM, 2010SP3, 2010SP2, 2010SP1, 2010RTM, 20075P3, 2007SP2, 20075P1,
2007RTM.
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1.2 Supported Outlook versions
Granular Restore for Microsoft Exchange and SQL supports the following versions of PST/OST files:

2016, 2013, 2010, 2007, 2003, XP, 2000, 98 and 97

Note

OST file of 2013, 2016 version is not supported.

1.3 Supported SQL Server database versions

Granular Restore for Microsoft Exchange and SQL supports the following versions of MDF/BAK files: 2017,
2016, 2014, 2012, 2008R2, 2008 and 2005

1.4 System requirements
Basic system requirements:

e Operating systems: Windows 10, Windows 8.1, Windows 8, Windows 7, 2016 Server, 2012 R2 Server,
2012 Server2008 Server

e RAM: 1024MB, depends on store size and OS version
e Hard Disk: minimum 50MB of free space required for installation
e Display: 800 x 600 or higher resolution, 256 colors
Additionally, Granular Restore for Microsoft Exchange and SQL may require free space on disk 1.5x the size of

mail store being processed. For example, for 300MB store, 450MB free space should be available.

1.5 Live Exchange Server export requirements

Exchange Server
Exchange Server 2016, 2013, 2010 or 2007

Exchange Web Services enabled on Exchange Server

Network

Port 443 open on the network. The EWS messages are transported via SOAP-based API, which is essentially
sending XML data using https protocol.

Restore client
GRE installed. Access to Exchange server(s) over network.
1.6 Live SQL Server export requirements

SQL Server
SQL Server 2017, 2016, 2014, 2012, 2008R2, 2008 or 2005
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SQL Server Browser running on SQL Server

Network

To establish connection to live SQL Server, remote network access must be allowed on the server and TCP/IP

protocol must be enabled in SQL Server Configuration Manager. For detailed instructions on how to do it, visit

http://blogs.msdn.com/b/walzenbach/archive/2010/04/14/how-to-enable-remote-connections-in-sql-

server2008.aspx

Restore client

GRE installed. Access to SQL Server(s) over network.

l1.6.1

Limitations

The current version of the product has the following limitations:

While processing dirty shutdown databases storages may be restored not to the topical condition
Messages in the Outbox folder are not restored if they haven't been syncronized with the server
Simultaneous recoveries are not supported

Simultaneous running of more than one instance of the product is not supported

Encrypted emails are not restored

Messages with size over 64MB are not supported

Windows 2000, 98, ME and 95 are not supported

Recovery of delivery receipts and non delivery reports is not supported

Tool doesn't support usage in "Run as different user" mode

OST files, created in Outlook 2013, 2016 are not supported

Password-protected PST files are not restored in command-line interface

Command-line interface is not supported for MDF and BAK files

Compressed SQL Server 2014, 2016, 2017 BAK files are not currently supported

System MDF and BAK files are not currently supported

Encrypted SQL databases are not currently supported

Calculated fields and fields of type [sgl_variant] in indexes cannot be used in SQL database search
Sparse columns in SQL database are not supported

Filestream data type and Filetables in SQL databases are not currently supported

Searching by 'real' data type may return not full results

Approved status of Calendar Events is not supported

Links to the Exchange Global Address List are not supported

MS SQL Server: schemas with name containing a dot (".") - for example, "[custom.schema]" - can not
be restored
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MS SQL Server 2017: restore of graph tables is not supported

Injection limitations for Exchange Server

Injection will not be supported for Exchange Server 2003 and earlier versions. These versions do not
support EWS.

Archived mailboxes (and items from such mailboxes) are not exported to live Exchange Server.
Photos of contacts are not exported to original live mailbox in Exchange Server 2007.

Emails with embedded images and other OLE objects are displayed with an attachments icon after
exporting into live Exchange Server.

Creation time and modified time are not restored.
Exporting data into live public folder is not supported.
Exporting data from PST/OST files into original mailbox is impossible.

Contact groups and meeting requests cannot be exported into live Exchange Server 2007 instances.
Use export through PST for these item types.

Missing sent date is exported as current date/time into live Exchange Server.

Limitations for search in attachments content (available for EDB/PST/OST files)

Search in attachments does not work for:

Tip

Text contained in embedded OLE objects, WordArt and smart objects, charts etc. Documents metadata
(author, comments, tags etc.).

Marker symbols in lists (numbered or bulleted).
Text in header/footer.
XLS/XLSX: number values, formulas, cell comments.

PPT: tables content.

Note that the utility is best used for granular item extraction. The user interface of the program is

designed for ease of locating, selecting and exporting specific messages, folders or mailboxes. Entire

databases can be exported as well, but the restore time will significantly increase over a slow

connection. For bulk operations that involve exporting more than one mailbox it is typically better to
work with a local copy of the database.

1.6.2

Boundaries for optimal recovery and search

Usage of Granular Restore for Microsoft Exchange and SQL is optimal for files that do not exceed:

EDB:

EDB size: 2TB
Mailbox size: 100GB
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e Number of messages in the EDB file: 2,000,000

e Number of mailboxes in the EDB file: 2,000

e Number of messages in one mailbox: 100,000
PST/OST:

e PST/OST size: 100GB

e Number of messages in the PST/OST file: 200,000

e Number of folders in the PST/OST file: 1,000

e Number of messages in one folder: 100,000
MDF/BAK:

e MDF/BAK size: 1TB

e Number of tables in the MDF/BAK file: 1,000

e Number of rows in one table: 10,000,000

1.6.3 Customer support

For customer support, please see Carbonite Server Backup Support.

Tip
When contacting customer support with a technical issue, please have ready the program's log files

and the store you are having difficulty with.

To get log files, click File menu and choose Open log folder. Zip the contents of the folder and attach
the resulting archive to your support request.

If the log archive and/or mail store exceeds 10MB, it may be impossible to send them as an email
attachment. In that case, upload instructions will be provided to you upon request.
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2 Installation

This chapter describes the steps required to install Granular Restore for Microsoft Exchange and SQL.

Depending on your preferences, it is possible to install the product in default or advanced mode.

2.1 Default mode

Default mode provides simple setup that requires just a few mouse clicks to complete. For the sake of
simplicity, it does not offer any customization capabilities.

Granular Restore for Microsoft Exchange and SQL will be installed in a per-user folder and be available just for
your user account. You do not need local administrator privileges in this case. The default installation location
is "C:\Program Files\Carbonite Server Backup\" A shortcut for this program will be created on the desktop
automatically.

Step by step instructions:
1. Double-click on the setup file to start the installation process.

2. The Software License Agreement appears. Read it and accept the terms in the License Agreement.

Terms and *
Conditions

These terms and conditions, including

the Privacy Policy
(https://evault.com/terms/privacy-

molime N sadninks

1 accept the terms in the License Agreement

CARBONITE ¢
Server Backup Click Install to install the product with default options just for
you. Click Advanced to change installation options.

3. Click Install to start setup .

4. The installation will start. When finished, you will have an option to launch the installed product.

10
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2.2 Advanced mode

Advanced setup mode allows changing default installation options.

Step by step instructions:

1. Double-click on the setup file to start the installation.

2. The Software License Agreement appears. Read it and accept the terms in the License Agreement.

CARBONITE ¢
Server Backup

Terms and °
Conditions

These terms and conditions, including
the Privacy Policy
(https://evault

o

malicie N saidkai

I accept the terms in the License Agreement

Click Install to install the product with default options just for
you. Click Advanced to change installation options.

3. Click Advanced to change installation options described above.

4. Click Next to install the product to the default folder or Change to choose another folder. To add an
icon shortcut to the desktop for quick start of the program, check Create a shortcut for this program on

the desktop.

Destination Folder

Click Next to install to the default folder or dick Change to choose another. 0

Install Granular Restore for Microsoft Exchange and SQL to:

IC:\Program Files (x86)\Carbonite Server Backup\

Create a shortcut for this program on the desktop.

11
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5. Click Install to begin the installation. Click Back to change any of your installation settings. Click Cancel
to exit the setup wizard.

6. After the installation finishes you can choose to Launch Granular Restore for Microsoft Exchange and
SQL when setup exits to start the program automatically by clicking the appropriate checkbox. Click the
Finish button to exit the setup wizard.

2.3 Product activation

When starting Granular Restore for Microsoft Exchange and SQL for the first time, you are prompted to
activate the product by entering your license key.

Enter the license key, and provide the names of registered user and company. Click Next to finish the
activation.

File Help

Granular Restore for Microsoft Exchange and SQL

Support

g

Enter license key and registration information.
License key: Enterthe License key, supplied after the purchase
Name: | Enter your name
Company: "Evter(he name of the company {leave blank if the program will be used for personal needs) 1
Help ) Cancel Previous [ Activate Bl
Ready |831 |

Tip
When getting an error message, first of all check if the license key has been entered correctly. It’s best
to copy and paste the key to avoid typos.

12
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2.4 Product deactivation
Deactivation of the product should be used before product uninstallation.
Follow the steps below for successful deactivation:

1. Start the product. Go to the Help menu, click License manager.

-
File Options | Help

Contents and index F1

| Select mailboxes or folders to search

Go to customer support online
Go to Granular Restore for Microsoft Exchange and SQL web site

License manager |
About

(53 Andy Kort C:\Exchange Server Database\Maibox Database.edb
: Size: 904 Mb

Date: 3/13/2014

Version: Exchange Server 2013

[[]£9 HealthMailboxadeSae Fe5054860a1cf0218267
[[]£9 HealthMailboxbaa8042¢260149aa928ba554e

%g ::::; Capulet Transaction logs not used.

Eg m:epakmm 22 maiboxes. Select a maibox to display folders.
[]£9 Maria Woods Load time: 00:00:04

[1£39 Michael

[[]&9 Personal Archive - HealthMaiboxadeSae #eSb!  Display time: Local

[[] &9 Personal Archive - HealthMailboxbaa8042e260 PST encoding: Unicode (Microsoft Outiook 2003, 2007, 2010 and 2013)
[]&9 Richard Show deleted items: Only non-deleted items

[[]£9 Robett Rise Incomplete messages: Hide

[|§ Romeo Montague Search within attachments: On

-] &3 Tim Goodler

< 5 | Fileinfo |

Completed

2. Select Deactivate product license for this computer in the opened window and click Next.
3. Enteryour license key.

2 x
-

File Help

Granular Restore for Microsoft Exchange and SQL
Enter license key.
License key: [Your license key will be automatically displayed in this field.
Name: User Name
Company: Company
[ hee | Cancel | | Previous Deactivate |

Ready |831| .

4. Click Next to finish the deactivation.
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3 Opening a file

To directly open a file for browsing and export, launch Granular Restore for Microsoft Exchange and SQL and
click file open button on the taskbar or select File| Open from the menu. On first launch, the file open dialog
will be shown automatically.

Select the store you will be working with and click Open.

Look in: ’ | Exchange Server Database v‘ 6 % Al B g

~

Name Date modified Type

() Mailbox Data 8/16/20124:26 AM  Exchange Server ...
Recent places i iibox Database 3/13/2014 351 AM  Exchange Server ..,

File name: ‘ Mailbox Database

Files of type: | All supported formats {*.edb, *pst. * ost, *mdf, * bak)
Pathtologfiles: | || Browse..

By default, a progress window will accompany opening the selected file. The window displays overall progress
and information about the number of items and objects in the file (1). The window can be disabled by
unchecking the Show the dialog next time check box (2) or from the Options menu. The progress window will
be automatically closed in 3 seconds after database opening (3).

|

Read spee

Elapsed time

Show the dialog next ime 1@

Current operation can be cancelled right on the progress dialog, by clicking an appropriate link.

14
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After loading the file is complete, it will be available for browsing and export. The opened store will also
become the default store and will be automatically reopened next time you launch the utility.

Opened database can be reloaded with database log files. Go to the File menu and select Reload database
using transaction logs.

File | Options Help

Open file...

Recent | Select mailboxes or folders to search

Close file

eload database using transaction logs
Search for files to open... ilbox Database.edb

Export selected items into PST... Ctrl+S

; ; Exchange Server Database\Maibox Database.edb
Export into original Exchange mailbox... Ctrl+G e: 904 Mb

Cancel current operation Ctrl+N ite: 3/13/2014
irsion: Exchange Server 2013

Open log folder
Delete saved temp files and logs rnsacb’on logs not used.

uixj.a maiboxes. Select a mailbox to display folders.
-] &9 Maria Woods Load time: 00:00:04

(-] Michael

(#-[_] 5 Personal Archive - HealthMailboxadeSae e 5b! Display time: Local

-] =9 Personal Archive - HealthMailboxbaa8042e260  PST encoding: Unicode (Microsoft Outlook 2003, 2007, 2010 and 2013)
#-[]&9 Richard Show deleted items: Only non-deleted items
@[] Robett Rise Incomplete messages: Hide

@[5 Romeo Montague Search within attachments: On

@[5 Rudy Raid

-] Susane Tyler |

- ]9 SystemMailbox{adeSae F-e5b5-4860-a1cf-021¢

@#-[_]£9 Tim Goodler

< File info i

Completed

Note

If you closed the progress window, it can easily be shown again by clicking on the progress bar on the
status panel.

3.1 Finding a file

In case when the location of the file is unknown, it is recommended to scan existing drives to find the data.
Granular Restore for Microsoft Exchange and SQL scans local drives, as well as network drives and searches for
PST/OST, MDF/BAK and EDB files.

To start a new search click Search for files to open in the File menu.

15
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File | Options Help

Open file... Ctrl+0
Recent

Close file

Reload database using transaction logs

Export selected items into PST... Ctrl+S
Export into original Exchange mailbox... Ctrl+G
Cancel current operation Ctrl+N

Open log folder
Delete saved temp files and logs

Exit

Select mailboxes or folders to search

ailbox Database.edb

Exchange Server Database\Maibox Database.edb
e: 904 Mb

3te: 3/13/2014

rsion: Exchange Server 2013

rnsacb‘on logs not used.

mailboxes. Select a mailbox to display folders.

<

ey

-] &9 Maria Woods

-[]£39 Michael

(]9 Personal Archive - HealthMailboxadeSae #e5b

Load time: 00:00:05

Display time: Local

([ ] =9 Personal Archive - HealthMailboxbaa8042e260  PST encoding: Unicode (Microsoft Outiook 2003, 2007, 2010 and 2013)

1-[] 59 SystemMailbox{adeSae F-e55-4860-a1cf-021
-] &9 Tim Goodler

Show deleted items: Only non-deleted items

Incomplete messages: Hide
Search within attachments: On

| Fileinfo |

Completed

The following form appears, displaying the list of mounted disks:

Fie types by apphcation:
[#] Exchange Server " edb)
[¥] Outiook ("pst, “ost)
[¥] SQL Server ("md¥, “bak)

Custom match:

IExawie *edb.” ost

Date created

16
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Select a location to search in.

Select source: File types by application:

®mFs o) | Exchange Server ("edb)

(a New Volume (E:) Outlook (" pst, * ost)
SQL Server ("mdf, “bak)

Custom match:
]Example: *edb;"ost

Fiter: | All

Date created Date modified Type

Open fils

List of found files will be displayed. Double-click a file to open it.

Select source: File types by application:
[V i Local Disk (C:) Exchange Server ("edb)
C;New Volume (E:) Outlook (" pst, * ost)
SQL Server (*mdf, *bak)

Custom match:
lExample: “edb;"ost

Found files: . IAII

File Size Date created Date modified Type

C:\Exchange Server Database\Mailbox Dataedb 648 MB 6/22/2016 8/16/2012 Exchange Server (*.edb)
C:\Exchange Server Data...\Mailbox Database.edb 504 MB 1/24/2016 3/13/2014 Exchange Server (*.edb)
CA\DRTC_S\DREXATest\S...\AddFunctions sjbak 35.5 KB 8/18/2015 6/22/2016 SQL Server {".mdf, ~bak)
CADRTC_S\DREXATest\Script\Corfig.sj bak 287KB 6/21/2016 11/17/2017 SQL Server (*.mdf, *bak)
CADRTC_S\DREX...\ScreenShotsGenerate sjbak 81.6 KB 6/22/2016 6/22/2016 SQL Server {".mdf, *bak)
C:\DRTC_S\DREXATest\Script\UGApp sj bak 482 KB 11/17/2017 11/17/2017 SQL Server ("mdf, *bak)
CA\DRTC_S\DREXATest.. \UGMenuActions sjbak 49.2 KB 11/16/2017 11/17/2017 SQL Server ("mdf, “bak)
CA\DRTC_S\DREXATest\Script\UGTree sjbak =~ 29.6 KB 11/17/2017 11/30/2015 SQL Server (*mdf, “bak)
C:\DRTC_S\DREXATest\Script\Unit2.sj bak 653 bytes 11/17/2017 11/17/2017 SQL Server (*.mdf, *bak)

Openfle  Search complete. 24 file(s)found. | Clearlistandsearchagain | | Ext

17
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4 Granular Restore for Microsoft SQL

4.1 Finding and browsing data
In general, Granular Restore for Microsoft Exchange and SQL provides two modes of processing file data:

browsing the file tree and search. Using these, it is possible to efficiently form a set of objects for subsequent
export, including the necessary ones and excluding ones to be skipped.

A newly opened database is shown in the Browse mode.

File Options Help

Browse | Destination
=-[] vy AdventureWorks2012_CS_Data mdf i
&3 Programmabilty (4) Tables No Jve sevets connected.
- @[] Functions (11) Connect to a live serverto enable
[ Procedures (10) 71 objects. Select an object to display data. export of objects from source storage.
&3 Rules (0)
[]Z3 User Types (5)
+0m
@-[]C@ Views (20)

Folder info

Completed

4.2 Browsing database tree

Browse mode shows database in a tree-like structure and allows browsing folders and previewing individual
objects.

This mode is best for navigating to a specific object, when it is precisely known what data needs to be
extracted.

For example, a user may ask to restore some specific table. Expand the folder 'Tables' in the tree and select the
table. Available rows will be listed to the right of the tree. Please note that product will not try to load all rows
in table. Instead of that rows will be loaded by portions each time you navigate to the end of list.
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File Options Help

Search in Person.Address

| Browse |
=-[]43 AdventureWorks2012_CS_Data mdf
] Programmability (4)
2-[]C3 Tables (71)
1] dbo. AWBuildVersion (1)

[ ][] dbo.Databaselog (1,597)
-[_]] dbo.ErmorLog (0)
[ ][] HumanResources.Department (16)
--[J[7] HumanResources.Employee (290)
--[_][=5] HumanResources.EmployeeDepartmen
-[_][7] HumanResources.EmployeePayHistory
[ ][T] HumanResources JobCandidate (12)
[ _J[=] HumanResources.Shift (3)
B Foson cress (15614 |
[ ][] Person.AddressType (€)
[ ][] Person.BusinessEntity (20.777)
[ ][] Person.BusinessEntityAddress (19,614)
-] Person.BusinessEntityContact (309)
[ _][=5] Person.ContactType (20)
-.[ ][] Person CountryRegion (238)
)] Person. EmailAddress (13.972)
[C]] Person.Password (13,972)
2 [=] Person.Person (19.972)
[ ][] Person.PersonPhone (19,572)
[ ][] Person.PhoneNumberType (3)
--[_][=5] Person.StateProvince (181)
--[_][=] Production.Bil Of Materials (2,679)
[ ][] Production.Cutture (8)
[ ][] Production.Document (13)
--[_J[=] Production.lllustration (5)

S

AddressID  AddressLine1

1
2
3
4
5
6
7
8
9

10
"
12

1970 Napa Ct.

3833 Mt. Dias Biv.
7484 Roundtree Drive
9539 Glenside Dr
1226 Shoe St.

1399 Firestone Drive
5672 Hale Dr.

6387 Scenic Avenue
8713 Yosemite Ct.
250 Race Court
1318 Lasalle Street
5415 San Gabriel Dr.
9265 La Paz

8157 W. Book

4912 La Vuetta

40 Hlis St.

6696 Anchor Drive
1873 Lion Circle
3148 Rose Street
6872 Thomwood Dr.
5747 Shidey Drive
636 Vine Hill Way
6657 Sand Pointe Lane
80 Sunview Temace
9178 Jumping St.
5725 Glaze Drive

2
o
>

SILIIIIIFIIIIII I I IIIIII

No live servers connected.

Connect to a live server to enable
export of objects from source storage.

Completed

In case if SQL script of a table is necessary, just right-click on the table in the database tree and select 'Show
SQL script' in the context menu.

File Options Help

&

[érowse|

Search in Person.Address

=-[]43 AdventureWorks2012_CS_Data mdf
[Ja Programmabilty (4)
e-[]Ca Tables (71)

[CJF=] dbo AWBidVersion (1)
[ ][] dbo.Databaselog (1,557)
-] dbo.Emorlog (0)
[ ][] HumanResources.Department (16)
--[_][=5] HumanResources.Employee (290)
[ ][] HumanResources.EmployeeDepartmen
[ ][] HumanResources.EmployeePayHistory
[ ][] HumanResources.JobCandidate (13)

[[]=] HumanResources.Shift (3)
B WE=| Person. Addre=- 110 814V

Show SQL script

--[_][=5] Person.BusinessEntityAddress (19.614)
.[]7] Person.BusinessEntityContact (503)
[ ][] Person ContactType (20)
[ Person CountryRegion (238)
.[J] Person EmailAddress (19.972)
[ ][] Person.Password (19,972)
[ ][] Person.Person (19,572)
--[_][=5] Person.PersonPhone (19,572)
[ ][] Person.PhoneNumberType (3}
[ ][] Person.StateProvince (181)
.[J] Production BilOfMaterials (2.679)
[ Production Cutture (8)
[ ][] Production.Document (13)
[ ][] Production.lllustration (5)

<

AddressID  AddressLinel

W~ ;OB WwN =

—
=]

1970 Napa Ct.

9833 Mt. Dias Biv.
7484 Roundtree Drive
9533 Glenside Dr
1226 Shoe St.

1399 Firestone Drive
5672 Hale Dr.

6387 Scenic Avenue
8713 Yosemite Ct.
250 Race Court
1318 Lasalle Street
5415 San Gabriel Dr.
9265 La Paz

8157 W. Book

4912 La Vuelta

40 Hliis St.

6696 Anchor Drive
1873 Lion Circle
3148 Rose Street
6872 Thomwood Dr.
5747 Shirley Drive
636 Vine Hill Way
6657 Sand Pointe Lane
80 Sunview Temace
9178 Jumping St.
5725 Glaze Drive

CHEIBIIIIIIII I I BB I IIIBI »
<

v

No live servers connected.

Connect to a live server to enable

export of objects from source storage.

Completed
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Any particular row can also be scripted via context menu. By right click on the row, SQL script can be either
shown or at once copied to clipboard.

File Options Help

L} H Search in Person.Address ‘ P ‘ mr:-i_; e
. T = =
J Browse ‘ Zr ‘
-} AdventureWorks2012_CS_Data mdf i & ~
=} D 2 % ure Seviesy o A | AddressID  AddressLinel Addressline2  City Stat No live coansciad
&-[1C3 Programmabiy (4) 1 1970 Napa Ct. NULL Bothel 79
&-[]Ca Tables (71) 2 9833 Mt. Dias Blv NULL Bothell 79 Connect to a live server to enable
-[[]=] dbo. AWBLuildVersion (1) 3 iR 3 S Dnv P o e export of objects from source storage.
I8 o Datzbasel og {1,237 4 9539 Grmms.de' Dr ‘ NULL Bothell 79
[ dbo.ErorLog (0)
[ ] HumanResources.Department (16) 5 1226 Shoe St. NULL Bothell 79
-[]] HumanResources Employee (290) 6 1399 Firestone Drive NULL Bothell 79
[T HumanResources EmployeeDepatmeri| |7 5672 Hale Dr. NULL Bothel 79
--[ ][] HumanResources EmployeePayHistory '8 6387 Scenic Avenue NULL Bothell 79
--[_][] HumanResources JobCandidate (13) 9 a . Bothe!
-[]7] HumanResources. Shift (2) 10 Copy SQL script to clipboard Bothell 79
28 || Person. Address (19,614) 1 Show SQL script Bothell 79
-] Person AddressType (5) 12 — Bothel 79
O P BusinessEntity (20.777) = Search for similar data i &
[ ] Person BusinessEntityAddress (19.614) 14 Search for data related to [AddressID] Bothell 79
-1 S ol Al [ 1912 L2 Vueta WULL Bothel 79
-LE Pareo .CaTr:d L 233 16 40 Bl St. NULL Bothel 79
[ Person. CourtiyRegion (232) 17 6696 Anchor Diive NULL Bothel 79
[ ][] Person.EmailAddress (19,572) =
o 18 1873 Lion Circle NULL Bothell 79
[ ][] Person.Password (19,972)
[ Person Person (1.972) 19 3148 Rose Street nULL Bothel 7
I Pecson PersonPhone (1.572) 20 6872 Thomwood Dr. NULL Bothell 7
] Person PhoneNumberType (3) 21 5747 Shirey Drive NULL Bothell 79
-[[][] Person.StateProvince (181) 22 636 Vine Hill Way NULL Portland 58
-] Production. Bil OfMaterials (2,679) 23 6657 Sand Pointe Lane NULL Seattle s
[ ][] Production Cutture (8) 24 80 Sunview Temace NULL Duluth 36
-.[ ][] Production.Document (13) 25 9178 Jumping St. NULL Dallas 73
-] Production.llustration (5) vi26 5725 Glaze Drive NULL San francisco 91V
< > < >
Completed

Rows filtering provides the ability to easily find specific values in tables. To enable filtering, just start typing
necessary data, when focus is on the list or press Ctrl+F keys. Please note that rows filtering works only for
rows that was already loaded in current view.

File Options Help

L} H Search in Person.Address ‘ el ‘ % v =

| Browse | | Destination |

=-[]4) AdventureWorks2012_CS_Data.mdf A | AddressiD  Addressline AddressLine2  City StatePy
E:Eg gt 6872 Thomiwoad Dr. nuLL Bothel

: 5669 Ironwood Way NULL Kenmore

20
. ] dbo AWBLildVersion (1) 46 1 ) _
..[]] dbo.Databaselog (1,557) 55 591 Memiewood Drive NULL Snohomish
! 61
77
LS

No live servers connected.

Connect to a live server to enable
export of objects from source storage.

0] dbo.EmorLog (0) 7726 Dnﬂvloéd Drive NULL Monroe
-.[J[=] HumanResources.Department (16) 9693 Mellowood Street NULL Duvall
-] HumanResources Employee (290) 390 Ridgewood Ct. NULL Camation
[/ HumanR EmployeeDep
-] HumanR: Empl PayHistory
--[ ][] HumanResources.JobCandidate (13)

--[ ][] HumanResources.Shift (3)

B[ Person Acess (19514

-.[_][=] Person.AddressType (6)

--[ ][] Person.BusinessEntity (20.777)
-.[_][=5] Person.BusinessEntityAddress (19.614)

[ ][] Person.BusinessEntityContact (309)
[ ][] Person.Contact Type (20)

-.[_][=5] Person .CountryRegion (238)
--[_J=5] Person.EmailAddress (13,572)

--[ ][] Person.Password (19,972)
[J7] Person.Person (19,972)

[ ][] Person.PersonPhone (19,572)

[ ][] Person.PhoneNumberType (3)
-[J[] Person.StateProvince (121)

.[ ][=] Production.Bil Of Materials (2,679) Iwoo| I ‘ Where: All v ?
[ ][] Production Culture (8)
-.[ ][] Production.Document (13) [T] Select fittered items
.[J7] Production llustration (5) | [l | 8 o
< > < %

Completed

FIIIBI
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4.3 Using search
Granular Restore for Microsoft Exchange and SQL provides several ways to search for data:

e Standard search
e Search for related data
e SQL Query search

To access the Search tool, select a table where the search will be performed and click on the Search Bar (1)
located at the top of the window.

File Options Help

; ) U‘E l Géarch in Person.Address =

Browse | S ) ) . ) ) B fDﬁﬁnation‘r
=-[J) AdventureWorks2012_CS_Datamdf AddressiD  AddressLine1 AddressLine2  Ciy ‘
Eg g 1970 Napa . NuLL Bothel

: 9833 M. Dias Biv. NULL Bothel

1= dbo AWBuidVersion (1) .
) dbo.DatabaseLog (1,597) 743 Roundiree Dive L Fonel
9539 Glenside Dr wuLL Bothel

[ dbo.EmorLog (0)
.[]=] HumanResources.Department (16) 1226 Shoe St. NULL
[ HumanResources Employee (290) 1399 Firestone Drive NULL Bothell
[[17=] HumanResources Employee Departmert 5672 Hale Dr. NULL Bothell
~[JJ[7] HumanResources. EmployeePayHistory 6387 Scenic Avenue NULL

]
o
>

No live servers connected.

Connect to a live server to enable
export of objects from source storage.

0~ OO, WwN =

[]=] HumanResources.JobCandidate (12) 8713 Yosemite Ct. NULL
[1F=] HumanResources.Shift (3) | 250 Race Court NULL

|| Person Address (19.614) | a 1318 Lasalle Strest NULL
[J] Person AddressType (6) 5415 San Gabrel Dr. NULL
[ ][] Person.BusinessEntity (20.777) 9265 La Paz NULL
[T]T] Person.BusinessEntityAddress .(19,614) 14 8157 W. Book NULL
[C1=5] Person.BusinessEntityContact (509) 4912 La Vueta NULL
[ Person Contact Type (20) 40 Blis St NULL
[1] Person.CountryRegion (238) 5% And;lor Drive Nt
[ ][] Person.EmailAddress (19,972) T
] Person Password (1,972) o Cicle NULL
)] Person.Person (19,572) 3148 Rose Street NULL
[[]=] Person.PersonPhone (19,572) 6872 Thomwood Dr. NULL
[ Person.PhoneNumberType (3) | 5747 Shirley Drive NULL
[[]F] Person.StateProvince (181) | 636 Vine Hill Way NULL
[15] Production. BillOfMaterials (2,679) | 6657 Sand Pointe Lane NULL
[1=] Production Culture (8) 80 Sunview Temace NULL
-] Production.Document (13) 9178 Jumping St. NULL
[ Production. llustration (5) 5725 Glaze Drive NULL

$IBIIIIIIIIIIIIIIIIIBIII

&

|<

Completed

Search results will be displayed on separate tabs with the ability to select query results and export them either
into Live SQL Server or in the form of SQL script files which can be executed on server manually.
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File  Options Help

o) o |
U H Search in Person.Address l P ‘ - &=
ﬂrwsiJ Search1 X ‘ : D i |
A Person Address | AddressID  AddressLine1 StateProvincelC A

1970 Napa Ct.

9833 Mt. Dias Blv.
7484 Roundtree Drive
9539 Glenside Dr
1226 Shoe St.

1399 Firestone Drive
5672 Hale Dr.

6387 Scenic Avenue
8713 Yosemite Ct.
250 Race Court

1318 Lasalle Street
5415 San Gabriel Dr.
9265 La Paz

8157 W. Book

4912 La Vuetta

40 Hliis St.

6696 Anchor Drive
1873 Lion Circle

3148 Rose Street
6872 Thomwood Dr.
5747 Shirdey Drive
1902 Santa Cruz
99300 223rd Southeast
25111 228th St Sw
5509 Newcastle Road
7057 Srped Maple Cout

No live servers connected.

Connect to a live serverto enable
export of objects from source storage.

O~ W, WwN =

FIIIIIIIIIIIIFIIIIBIIIIIII

Completed

43.1 Standard search mode
To access Standard search click on the Search Bar and select 'Standard search' tab in the displayed window.

File Options Help

~~ B
: H Search in Person.Add .—r~
B n earch in rerson ress e %2 é"a

¥ Please enter search parameters.
’ Browse | | Destinati |
AdventureWorks2012_CS_Data.mdf
=] .[3:‘ Dva:l:m el am Standardsearch | Relateddata | SQL No v seevars Comedted.
EI-"D%EU% 1) Fields to search: Connect to a live serverto enable
7] dbo. AWBLildVersion (1) Alindexed field Cust dexed ~ export of objects from source storage.
][] dbo.DatabaseLog (1.597) o e i o
.[J] dbo.ErorLog (0) O Alfields O Custom
[ ][] HumanResources.Department (16)
~[[J[=] HumanResources.Employee (250) Multiple field match type:
--[_][=5] HumanResources.Employee Departmen’ ® 3
(I HumanResources EmployeePayHistory (® OR, records with one or more matching fields
-[][=] HumanResources JobCandidate (12) () AND, records with matches in all searched fields
[ ][=] HumanResources.Shift (3)
e Person Address (19,614) Fields:
[ ][] Person.AddressType (6) ~
- []7] Person BusinessEnty (20.777) L] AddressiD ©)
--[ ][] Person.BusinessEntityAddress (19.614) [] AddressLine1
[ ][] Person.BusinessEntityContact (309)
--[_][=5] Person ContactType (20) [T] AddressLine2
~[_J[=] Person.CountryRegion (238)
-[JI=] Person.EmailAddress (12,972) [ Cay
[ ][] Person.Password (19,972) )
[ Person.Person (19.972) [ StateProvincelD
[ ][] Person.PersonPhone (19,572)
] Person PhoneNumberType (3) | [ PostalCods
[ ][] Person.StateProvince (181)
[ ][] Production.BillOfMaterials (2,679)
--[_][=5] Production.Cutture (8)
--[_][=5] Production.Document (13) JTrCIampINg O vaias
][] Production. llustration (5) 5725 Glaze Drive San Francisco

Prefil Search

<
Completed
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There are three sets of parameters to customize for this search:

Fields to search (1)

This options defines the set of fields which will be used to perform search. The user can choose to search in all
indexed fields, all fields, custom selection from indexed fields or custom selection from all fields.

Multiple field match type (2)

In case more than one field is selected for search the user can choose which logical operator will be used to
combine these fields.

OR - search results will include records which have at least one field that matches search parameters.

AND - search results will include records which have matching values in all fields which were selected for
search.

Fields (3)

If Custom (indexed only) or Custom was selected in Fields to search the user will be able to choose fields which
will be used for search. To select a field simply click on the field name, the field will then become selected and
the user will be able to choose which comparison operator to use and to enter the value to search for.

There are also two ways to fill search fields with values from selected tow, which helps to avoid entering long
string manually:

e Right-click on a row and select Search for similar data from context menu. This fill set the field
selection to Custom and fill search from with values from selected row.

OR

e Select a row, then select Standard search tab and click Prefill button.
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4.3.2 Search for related data
Search for related data can be used to search for rows which relate to the selected row - that are rows which
have fields from the selected table as foreign keys.

Related data search can be accessed either by right-clicking on a row and selecting Search for data related to...
from context menu or by selecting Related data tab in search window.

File Options Help

= “_:lﬂ Search in Person Address ‘ P
L‘_/ L 01 ! 1

Please enter search parameters.

| Destination |

Browse
=-[]4) AdventureWorks2012_CS_Data mdf Standardsearch | Relateddata | SQL
@-[]Z@ Programmability (4) |
&-[C]C3 Tables (71) [ Fields: Connect to a live server to enable
[C1=] dbo.AWBLUildVersion (1) | AddressID I | export of objects from source storage.
-.[][=] dbo.Databaselog (1.597) I ; :
L] dbo.Emorlog (0) : Related tables:
[[J=] HumanResources.Department (16) { i i
[ ) HumanResources Employee (290) I Person. BusinessEntityAddress [Address|D]
[]=] HumanResources. EmployeeDepartmen
[ ][] HumanResources.EmployeePayHistory
[[1=] HumanResources.JobCandidate (13)
[[1=] HumanResources.Shift (3)
B Foron Arss (19519
[C]T] Person.AddressType (£)
[C]=] Person.BusinessEntity (20.777)
[T Person.BusinessEntityAddress (19,614)
] Person.BusinessEntityContact (309)
--[ ][] Person.ContactType (20)
[1] Person.CountryRegion (238)
[[JF=] Person.EmailAddress (19,972)
[C1=5] Person.Password (19,972)
[ Person.Person (19,572)
[ ][] Person.PersonPhone (19.572)
[C1=5] Person.PhoneNumberType (3)
[C1=] Person.StateProvince (181)
--[ ][] Production.BilOf Materials (2,679)
[[]=] Production Culture (8)
--[_][=] Production.Document (13) leo——Jrrooumping oc: vanas |
[ Production. llustration (5) [ 5725 Glaze Drive San Francisco 9 V|
< >

No live servers connected.

Sales.SalesOrderHeader [Bill ToAddress|D]; [Ship ToAddressID]

Prefil [ search |  Cear

Completed

The application will analyze the selected table and automatically detect which fields are used in other tables as
foreign keys (1). It will also provide a list of tables which relate to the selected table (2).

The user will then be able to enter field values which will be used when searching for related data and select
from a list of tables where to perform search.
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4.3.3 SQL Query mode
SQL Query search mode provides the ability to write complex search queries using SQL-like query language to
narrow search results as much as possible.

SQL query mode can be accessed by clicking on Search Bar and selecting SQL tab.

File Options Help

Search in Person.Address

Please enter search query.
Browse Destination

=-[]¢) AdventureWorks2012_CS_Data.mdf Standard search Related data sQL
@-[JE@ Programmabilty (4) |
e-[]Ca Tables (71) SELECT * FROM Person.Address WHERE Connect to a live server to enable
[ ]=] dbo.AWBUildVersion (1) export of objects from source storage.
[[J=] dbo.Databaselog (1.597) )
[C]=] dbo.EmorLog (0)
--[_][=] HumanResources.Department (16)
[[1=] HumanResources.Employee (250)
[ ][] HumanResources.EmployeeDepartmen
[[1=] HumanResources.EmployeePayHistory
[[1=] HumanResources.JobCandidate (13)
[ ][] HumanResources.Shift (3)
] Porson Address (15514
[ ][] Person.AddressType (6)
-.[ ][] Person.BusinessEntity (20.777)
] Person.BusinessErtityAddress (19.614) - Please ent_er the remaining part of the query to seard_l for data.
][] Person BusinessEntityCortact (309) ;I;he( f:!l\o:vanQ operators are supported in search queries: AND, OR. (. ). <. 9)
[C1=] Person ContactType (20) b Eamoies:
[ ][] Person.CountryRegion (238) 1) De;p)anmem='Engineeﬁng' AND Age>42
[ ] Person EmailAddress (19,972) | 2) Name="Steve’ OR Salary>=100000
] Person.Password (19,572) 3) (Department="Marketing' OR F’osﬂ_ion=_'lrrler_n').AND Age<30 )
- AR | 4) Salary>100000 OR (Department="Engineering’ AND (YearsOf Service<5 OR
--[ ][] Person.Person (19 9/‘4‘, ' Posttion="ntem)
[C]=] Person.PersonPhone (19.972) | 5) Department LIKE “%keting’ OR (Postion LIKE *_ntem’ OR Postion LIKE
[[]=] Person.PhoneNumberType (3) ‘Takintem)
--[ ][] Person.StateProvince (181)
[C1=] Production.BillOfMaterials (2,679)
[ ][] Production Culture (8)
[C1=] Production.Document (13) . I TIUampINg oK valias
[[1=] Production.llustration (5) 5725 Glaze Drive San Francisco

No live servers connected.

Prefill Search Clear

<
Completed

The user is presented with a text field (1) which is used to enter search query. The beginning of the query is
given and the user has to fill in the remaining part of WHERE clause.

The query may include field names, comparison operators, field values, logical operators and brackets. The text
field makes it easier for entering search query by providing auto-complete feature, which automatically
suggests possible query elements. The auto-complete window will appear automatically when first letters of
query are typed, it can also be accessed by pressing Ctrl+Space. To select an item (field name, logical or
comparison operator) from the list please press Tab or Enter.

Query examples are given at the bottom of the SQL tab (2).

4.4 Exporting items

Granular Restore for Microsoft Exchange and SQL allows a user to export the whole database or just particular
objects (tables, views, functions, etc.) into live SQL Server and to SQL scripts, that can be used for manual
import to a live server.
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4.5 Restore to live SQL Server

Granular Restore for Microsoft Exchange and SQL includes the injection capability for items (tables, views,
functions, etc.) from offline database and BAK file to live SQL database.

The following options are presented:

e Authentication

e Connection to a database using valid credentials. To provide the connection, host (domain name or IP),
user logon name and password are required. It is also possible to connect through current Windows
credentials.

e Connecting to several tables on different servers simultaneously.

e Browsing folder hierarchy of a connected database, browsing folder contents and viewing objects and
rows.

e To provide injection, running the application as administrator or using a machine from AD domain, in
which there is SQL Server with destination database, is not required.

45.1 Connection to SQL Server
To establish a new connection, use the button Connect to live server (1) , next to the Search field or go to File-
>New connection->Attach to live SQL Server database (2).

.
File | Options Help
Open file... Ctrl+0

Recent

Close file

Destination

New connection Attach to live SOL Server database... Ctrl+Q e
Search for files to open... ventureWorks2012_CS_Data. J No live servers connected.

Connect to a live server to enable
: or- export of objects from source storage.
Export into live server... Ctrl+E Liidserver\Testing\TestCases\msr\Sample\AdventureWorks2012_CS\#
Cancel current operation Ctrl+N ze: 188 Mb
te: 5/21/2012
Openllogfoldes rsion: SQL Server 2012
Delete saved temp files and logs

Save selected objects into SQL scripts...  Ctrl+S

tables. Select a table to display records
time: 00:00:02

) oy
[C1=] Person Address (19.614)
--[ ][] Person.AddressType (6)
[C1=] Person.BusinessEntity (20.777)
[C1=] Person.BusinessEntityAddress (19,614)
-.[ ][] Person.BusinessEntityContact (309)
[C1=] Person ContactType (20)
[C]=] Person CountryRegion (238)
-.[_][=5] Person.EmailAddress (19,972)
[C1=] Person.Password (19,972)
--[ ][] Person.Person (19,972)
[C1=] Person.PersonPhone (19,572)
[C1=] Person.PhoneNumberType (3)
-.[ ][] Person.StateProvince (181)
[[J[=] Production. BilOf Materials (2,679)
[ ][] Production Culture (8)
[C1=] Production.Document (13) <

[(1F=] Production. llustration (5) wh o~
< > File info

Completed
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To access the server, enter the domain name or the IP address, or just click on the arrow (1) to get the
dropdown list of automatically detected servers and provide valid credentials.

Server name (gx.: contoso.com\MSSQLSERVER or 192.168.0.5\MSSQLSERVER):

OR-ENVSERVER\ORENVSS

Use cument Windows credentials

Please _enterthe server address and provide user
SQL Server login {ex.: user1): credentials for connection.

The application will then fetch the list of databases

available on the target server.

After that you will be able to choose the desired
database from the list and connect.

Password:

[T] Save password

List of available databases will be shown after clicking the Refresh button (1) or the arrow near the Database
name field (2), if entered credentials are correct.

Server name (ex.:i contoso.com\MSSQLSERVER or 1&.1@.0.&MSSQ§ERWE):
WS20125QL

[] Use cument Windows credentials :
Please enter the server address and provide user

SQL Server login {ex.: user1): credentials for connection.
Hek The application will then fetch the list of databases
available on the target server.

After that you will be able to choose the desired
database from the list and connect.

Password:

[........

[T] Save password

Database name:

I
AdventureWorks2012
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4.5.2

Once data has been selected, click the Export button and select an Export option.

Injection workflow

File Options Help

| ,“/ H | Search in Person.Address

Browse

=-[8] ) AdventureWorks2012_CS_Data.mdf

<

@#-[]C3@ Programmability (4)

=-[w]C3 Tables (71)

[ ][] dbo.AWBLildVersion (1)

-.[ ][] dbo.DatabaselLog (1,597)

.[[][=] dbo.ErorLog (0)

[ ][] HumanResources.Department (16)
--[_]=] HumanResources.Employee (250)
--[_][=] HumanResources.EmployeeDepartmen
..[][=5] HumanResources.EmployeePayHistory
--[ ][] HumanResources.JobCandidate (13)

-.[ ][] HumanResources.Shift (3)

B | oson faess (15616

-.[][=] Person.AddressType (6)

--[ ][] Person.BusinessEntity (20.777)

-.[ ][] Person.BusinessEntityAddress (19,614)
[ ][] Person.BusinessEntityContact (309)
-.[][=] Person ContactType (20)

.[]7=] Person CountryRegion (232)

-.[][=5] Person.EmailAddress (19,572)

[ ][] Person.Password (19,972)

-.[][=5] Person.Person (19,972)

-.[][=5] Person.PersonPhone (19.572)

[ ][] Person.PhoneNumberType (3)

[ ][] Person.StateProvince (181)

--[_][=] Production.BillOfMaterials (2,679)
-.[][=5] Production.Cutture (8)

--[_][=] Production.Document (13}

-.[]=] Production.lllustration (5)

Completed

© W~ DD W N

A| AddressiD  AddressLinel

1970 Napa Ct.
9833 Mt. Dias Blv.
7484 Roundtree Dri
9533 Glenside Dr
1226 Shoe St.
1399 Firestone Driv
5672 Hale Dr.
6387 Scenic Avent
8713 Yosemite Ct.
250 Race Court
1318 Lasalle Street
5415 San Gabriel D
9265 La Paz

8157 W. Book
4912 La Vuetta

40 Hlis St.

6696 Anchor Drive
1873 Lion Circle
3148 Rose Street
6872 Thomwood D
5747 Shirey Drive
636 Vine Hill Way
6657 Sand Pointe L
80 Sunview Temact
9178 Jumping St.

5725Glaze Drive Vv
>

Destination

=-E5 Ws20125aL
B3 AdventureWorks2012
{3 Programmability (4)

3 Tables (71)
--{=] dbo.AWBLUildVersic
-.[=] dbo.Databaselog
{7 dbo.EmorlLog (0)
-.{=] HumanResources.
--{=] HumanResources.
-.{=] HumanResources.
--{=] HumanResources.
-.[=] HumanResources..
--{=] HumanResources.
R o s (1
-.{=] Person.AddressTyr
--{=] Person.BusinessEr
-.{=] Person.BusinessEr
-.[=7] Person BusinessEr
-.{=] Person Contact Typ
.[=] Person CountryRe¢
-.{=] Person.EmailAddre
=] Person.Password
.[=] Person.Person (19
.[==] Person.PersonPho
-.[=] Person.PhoneNum
-.{=] Person.StateProvir
.[=] Production.BillOfM:
--{=] Production.Cutture
[ Production.Docum: ¥
>

TR T R SO N

A AddresslD  AddressLine1

1970 Napa Ct.

9833 Mt. Dias Blv.
7484 Roundtree Drive
9539 Glenside Dr
1226 Shoe St.

1398 Firestone Drive
5672 Hale Dr.

6387 Scenic Avenue
8713 Yosemite Ct.
250 Race Court
1318 Lasalle Street
5415 San Gabriel Dr.
9265 La Paz

8157 W. Book

4912 La Vuelta

40 Hlis St.

6696 Anchor Drive
1873 Lion Circle
3148 Rose Strest
6872 Thomwood Dr.
5747 Shirey Drive
636 Vine Hill Way
6657 Sand Pointe Lane
80 Sunview Temace
9178 Jumping St.
5725 Glaze Drive

Selected:ri objedfs)

Granular Restore for Microsoft Exchange and SQL presents several injection modes for specified data:

e Export to original object — The source object will be restored to the object listed under Desination

Object.

e Export to new object — The user may edit the Destination Object for any source object, and the
Granular Restore application will create a new destination object to restore to.

e Schema only — Export only the schema of the source objects. The destination object can be edited and
the schema(s) will be restored to the new destination object.

e Unselect successfully exported objects — This will unselect the data objects that were selected for

export once they have been successfully exported to the live server. This will allow the user to more

easily identify which objects encountered errors and were not exported.
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Destination database:

WS20125QL\AdventureWorks2012

Loading objects to export.

Source object
B® [Person].[Address]

Destination object

®) Export to original object {create if not exists) Bqort to new object I Schema only

[ Unselect successfully exported objects

4.6

To save objects marked for export, click the Export selected objects into SQL scripts button on the toolbar or
select the point in the File menu.

Restore to SQL scripts

File Options Help

| Browse

<

Search in Person.Address

| =218 AdventureWorks2012_CS_Datamdf
@3- C]C3 Programmabilty (4)
=-[=]C3 Tables (71)

[ dbo AWBLildVersion (1)

[J7=] dbo.DatabaseLog (1.557)

[ dbo.Emorlog (0)

[]=] HumanResources.Department (16)
[1=] HumanResources.Employee (290)

[[17=] HumanResources.EmployeeDepartmen

[1] HumanResources. EmployeePayHistory

[~ HumanResources JobCandidate (13)
= HumanResoum Shift (3)

2 3 e

Person}ddressType 16)

DG Person.BusinessEntity (20.777)

[[17=] Person.BusinessEntityAddress (19.614)

[C]=] Person.BusinessEntityContact (309)

[1=] Person.Contact Type (20)

[[1=] Person CountryRegion (238)

] Person EmailAddress (13,572)

[1=] Person.Password (19,972)

[C]= Person.Person (19,572)

] Person.PersonPhone (19,.572)

[[17=] Person.PhoneNumberType (3)

[ Person.StateProvince (181)

[[]=] Production.BillOfMaterials (2,679)

[[]= Production Culture (8)

[1F=] Production.Document (13)

DE Production.lllustration (5)

AddressID  AddressLine1

1970 Napa Ct.

9833 Mt. Dias Blv.
7484 Roundtree Drive
9539 Glenside Dr
1226 Shoe St.

1399 Firestone Drive
5672 Hale Dr.

6387 Scenic Avenue
8713 Yosemite Ct.
250 Race Court
1318 Lasalle Street
5415 San Gabriel Dr.
9265 La Paz

8157 W. Book

4912 La Vuelta

40 Hlis St.

6696 Anchor Drive
1873 Lion Circle
3148 Rose Street
6872 Thomwood Dr.
5747 Shirey Drive
636 Vine Hill Way
6657 Sand Pointe Lane
80 Sunview Temace
9178 Jumping St.
5725 Glaze Drive

Bothell

Bothell

Bothell
Portland
Seattle

Duluth

Dallas

San Francisco

VORI BIIIIFIIIIIII I I I BB BEEIE @

<

No live servers connected.

Connect to a live serverto enable
export of objects from source storage.

Completed

Selected: 1 object(s)
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To start exporting process, select destination folder or create a new one and click OK.

Selected data will be saved into SQL script(s). To start the export select the
destination folder or create a new one and click OK. The export process will start
immediately.

| Documents

& Downloads

b |t Favorites
P Links

o Music
I & Pictures

B Saved Games
b & Searches

I Videos

| Make New Folder |

Required time depends on how many objects are selected for export. By default, a progress window appears
after the export starts. The window shows the number of saved objects and rows (1). You can disable the
progress window directly in the window or go to the Options menu and select Show progress dialog. The
export can be cancelled by clicking an appropriate link in the progress dialog window (2) or by clicking the
Cancel Export button (3) on the task bar.

File Options Help

Search in Person.Address

_ Destination

Al AddmeeIN  Addemeelinal Addracelina? (e

a
>

VI3 Programmability (4) No live servers connected.

2 [ Tables (71)
[V dbo AWBUildVersion (1)
[¥][7] dbo.Databaselog (1.597)

Progress
Connect to a live server to enable

export of objects from source storage.
Exporting objects... 94%

[¥][7] HumanResources.JobCandidate (13)
[¥]=] HumanResources.Shift (3)

g Peron A (15610

[ Person.AddressType (6)

[=] Person.BusinessEntity (20.777)

[ Person.BusinessEntityAddress (19,614
[¥][=] Person.BusinessEntityContact (309)
[V Person.Contact Type (20)

[V Person.CountryRegion (238)
[¥]=] Person.EmailAddress (19.972)

[ Person.Password (19,972)

[=] Person.Person (19,972)

=] Person.PersonPhone (19,572) [

[=] Person.PhoneNumberType (3) ;21
[V Person StateProvince (1281) 2 636 Vine Hill Way
[¥I[=] Production.BillOfMaterials (2,679) |23 6657 Sand Pointe Lane
[¥]=] Production Culture (8) 24 80 Sunview Temace

Close

Show the dialog next time

Bothell
Bothell
Portland
Seattle
Duluth
Dallas

|20 6872 Thomwood Dr.
5747 Shirey Drive

[¥][=] Production.Document (13)
~| Production.llustration (5)

<

9178 Jumping St.
5725 Glaze Drive

<

San Francisco

vORSIBIIIIIFIIII I IIIIIE sa‘:

Exporting objects... 93%

| 00:01:33

Selected: 95 object(s)
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Tip

If you closed the progress window, it can be shown again by clicking on the progress bar on the status
panel.

4.6.1 Restoring exported scripts into SQL Server
SQL scripts exported from the offline database can be easily imported into live SQL Server manually

For this purpose a special bat-file, commit.bat, is generated while extracting data. It is stored in the folder with
restored scripts.

Usage for trust connection:
commit.bat server name db name
Usage for mistrust connection:

commit.bat server name db name user name password
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5 Granular Restore for Microsoft Exchange

5.1 Special features

Usage of Granular Restore for Microsoft Exchange and SQL can be more comfortable for a user due to
additional Options menu, which allows user to customize program work.

Detailed information about every option is described in this help section.

Note

PST encoding and Show deleted items options are not available for PST/OST files.

5.2 PST encoding

Exporting mail store data into PST allows to select a PST format that suits your version of Microsoft Outlook.
Outlook 2003, Outlook 2007, Outlook 2010 and Outlook 2013 process both Unicode and ANSI PST files, but as
for older versions of Outlook, they will not be able to open Unicode formatted PST files. Previous versions of
Outlook were using only ANSI format. The main reason for this change was to allow for international character
support and to extend the maximum size of PST files beyond the 2GB limit of the ANSI formatted PST files. In
Granular Restore for Microsoft Exchange and SQL there are two ways to select suitable encoding for output
PST.

Output PST encoding can be changed while selecting a destination folder for restored PST files.

Selected data will be saved into pst file(s). To start the export select the destination
folder or create a new one and click OK. The export process will start immediately.

4 | CLIENT-PC A
. Recovery 002 - AdventureWorks2012_CS_Data.mdf

. Recovered_sessionl

. Recovered_session2
. Recovered_session3
, Recovered_sessiond
. Recovered_session5

. Recovered_sessionf

TestRenorts

PST encoding:

g nicode (Microsoft Outlook 2003, 2007, 2010 and 2013)

| Make New Folddla S (Microsoft Outlook 2002 and earlier

Alternatively, encoding for the output file can be changed in the Options menu at any time the program runs.

Selected value will be saved and used on the next program launch.
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]
m

Options | Help

Show notification panel
¥ | Show progress dialog
~———1{| ¥ | Search within attachments

PST encoding > | Unicode (Microsoft Outlook 2003, 2007, 2010 and 2013)
Incomplete messages 4 ANSI (Microsoft Outlook 2002 and earlier)

s'iww defeted e ! C:\Exchange Server Database\Maibox Database.edb
Display time > Size: 904 Mb

-9 HeatthMailboxadeSae He5b54860a 1cf0218267 \[/)::Selor?/ lg(/czhoaﬁ;e Server 2013
-[[] 9 HealthMailboxbaa8042e 260145aa928ba554( :
[J&3 John
-[1£9 Juliet Capulet

v1-[] 9 Kyle Pak
Eg L::; i 22 maiboxes. Select a maibox to display folders.

-] 59 Maria Woods Load time: 00:00:04
[1£9 Michael
-[]&9 Personal Archive - HeatthMaiboxadeSae ie5b!  Display time: Local

-[[]&9 Personal Archive - HealthMailboxbaa8042e260 PST encoding: Unicode (Microsoft Outiook 2003, 2007, 2010 and 2013)
Show deleted items: Only non-deleted items

Incomplete messages: Hide

Search within attachments: On

‘Seled mailboxes or folders to search

m =
T 1D
B-m-m-m ] € E}

Transaction logs not used.

-[]&9 Romeo Montague

[} Rudy Raid

-[]&9 Susane Tyler

]9 SystemMailbox{adeSae -e5b5-4860-a1cf-021

T | File info |

Completed

5.3 Incomplete messages

Incomplete messages, such as messages with missing properties, bodies, are hidden by default. This option can
be changed in the Options menu.

Options | Help
Show notification panel

Show progress dialog Select mailboxes or folders to search

Search within attachments

PST encoding

Database.edb

Incomplete messages
Show deleted items

: g : ange Server Database\Mailbox Database.edb
Dispisy hme Size: 904 Mb

Date: 3/13/2014

Version: Exchange Server 2013

o - -

9 HealthMailboxade 9ae He5054860a1cf0218267
9 HealthMailboxbaaB042e2601492a928ba554e(

Transaction logs not used.

22 maiboxes. Select a mailbox to display folders.
Load time: 00:00:04

<

-] &9 Tim Goodler

9 Personal Archive - HealthMailboxade Sae e5b!
(=9 Personal Archive - HealthMailboxbaa8042e 260
9 Richard

5 Robert Rise

9 Romeo Montague

5 Rudy Raid

9 Susane Tyler

9 SystemMailbox{adeSae F-e5b5-4860-a1cf-021

Display time: Local

PST encoding: Unicode (Microsoft Outiook 2003, 2007, 2010 and 2013)
Show deleted items: Only non-deleted items

Incomplete messages: Hide

Search within attachments: On

'\ File info |

Completed
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Note

After changing the way of displaying incomplete items, the database will be reopened.

5.4 Showing deleted items
Granular Restore for Microsoft Exchange and SQL provides an ability to process deleted items and folders.
This special feature can be enabled via the Options menu. There are three available display modes:

e non-deleted items - displays actual items in folders
e show only deleted items - displays items/folders deleted from a mailbox hierarchy, but not physically

e show both deleted and non-deleted items - displays both actual items in folders and items/folders
deleted from a mailbox hierarchy.

Note that after selecting any way of processing deleted items, the database will be reopened.

Items, deleted from Exchange Server 2010 and 2013 databases, are stored in the folder Deletions and have an
appropriate type.

File Options Help
Search in Andrew Wait

Browse
=-[]&) Maibox Data.edb " § Subject fom  To Created

@[ 159 /o=NoSuchEmai/ou=Exchange Administrat JESSICAlamsorythou  Dalia  Romeo Montague; Tim Gooder; Maria ... Thursday, August 16, 2012 3:00:17A...

g%g :‘:;‘:: d‘;,a.ﬁ ABHORSON Doyoucall  Michael  Andrew Watt; Susane Tyler: Juliet Cap... Thursday, August 16, 2012 3:00:12A...

-[] |23 Calendar {0)
[]42] Contacts (0)
[ Deleted kems (0)

O
[ Drefts (0)

-[J3 Inbox (0)

] &l Joumal (0)
[ Junk E-Mail (0)

[ ] Notes (0)

[ Outbox (0)

--[](Z@ Sent tems (0)
[JA Tasks (0)

&-[]55 Andy Kort

@-[]£9 Brian

@[3 Dalia

&-[]&9 John

-[_] 59 Juliet Capulet

#-[]£9 Kyle Pakerman

&[5 Luise

[

[

[

[

[

£

-

-[_] £ Maria Woods
o129 Michael
o[ &9 Richard
-[_] 5 Robert Rise

-[_] =9 Romeo Montague
[ ]9 Rudy Raid

<
Completed

As for items deleted from Exchange Server 2007 databases, they are stored in the their original folders but can
be easily recognized by an appropriate status.
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Note

Items, stored in the folder Deletions, cannot be recovered to live Exchange Server database. It is
recommended to restore items from the Deletion folder to PST and then import to live Exchange Server.

5.5 Display time
There are two dates display formats available for users, local time and GMT.
To switch dates display format between local computer time and GMT, use the Options menu.

Options | Help

Show notification panel

| Search in Alex Clark ‘ pel

Show progress dialog
Search within attachments

PST encoding =z Fon To Created * Al

Incomplete messages Z She was glad that Jo shoul... Luise Maria Woods; Kyle Pakerman; Luise; ... Wednesday, March 12, 2 ‘
Show deleted items B In itsnature, it is arbitrary an... Kyle Pakerman Andrew Wait; Richard; John; Dalia; Ro... Wednesday. March 12, 2

It is my lady mother. Itismy... Juliet Capulet Romeo Montague; Richard; Dalia; Mic... Wednesday, March 12, 2
Butthat it might not appeart... John Romeo Montague; Andy Kort; Robert ... Wednesday, March 12, 2
Do you persuade yourself t... Andy Kort Susane Tyler; Andy Kort; Juliet Capulet... Wednesday, March 12, 2
] | regret that | am unable tor... Brian John Brian; Tim Goodler; Kyle Paketm Wednesday, March 12, 2
[ Junk Email (0) l:l-ﬂ
[Je Notes {40) He went up a dark and narr... Rudy Raid &lan Michael; Rlchard Dalia; Luxse s Wednesday March 12 2
Noone, even there, could li... Romeo Montague  Brian; Alex Clark; Richard; Romeo Mon... Wednesday, March 12, 2
g One of the things particular... Robert Rise John; Maria Woods; Richard; Alex Clar... Wednesday, March 12, 2
g Stephen Brice read the ne...  Luise Alex Clark; John; Tim Goodler; Michael... Wednesday, March 12, 2
g Give me some light! Give m... Michael Romeo Montague; Richard; Andrew W... Wednesday, March 12, 2
a His condition leaves him no... Juliet Capulet Romeo Montague; Richard; Juliet Cap... Wednesday, March 12,2 v

Display time

~ Oooood

Alas. the heavy basketwhich the Colonel carried on his arm was

(=9 HealthMailboxadeSae Fe5054860a1cf0218 N

7-[_] =9 HeatthMailboxbaa8042¢260149aa928ba55
7-[]59 John From: Alex Clark 6 attachment(s):

£

£

£

£

£

£

[ -

- 159 Julet Capulet Sent  Wednesday, March 12, 2014 10:29:00 AM UTC-07:00 ladloR g, 2758

(]9 Kyle Pakeman | ESSAYS-7.txt, 2.22 KB

[]...Dg Luise To: Dalia” <Dalia@no-such-email.com>, "Kyle Pakerman” <Kyle.Pakerman@no... g o

-] &9 Maria Woods Cc: "Dalia” <Dalia@no-such-email.com>, "Kyle Pakerman” <Kyle.Pakerman@no... \_I SR

- [159 Michael || ESSAYS-42.6¢t, 561 bytes

[]---D§ Personal Archive - HealthMailboxadeSae e B 4 she did not lift her voice at dinner, which was very poor indeed for || ESSAYS-46.txt, 2.08 KB

[#-[_] 9 Personal Archive - HealthMailboxbaa8042e.  Colonel Carvel's house. All day long Virginia, assisted by Uncle Ben and I ESSAYS-48 txt. 2.31 KB

- _]£3 Richard Aunt Easter, toiled in the stifling kitchen, preparing dainties which = i

-]/ Robett Rise she had lona denied herself. At evenina she went to the stationat ¥
l Preview ‘ Proper;ies ‘

<

Completed

If you switch display time, a warning, that the file will be reloaded, appears.

Switching display time requires reloading the file. This may take a long time. Do you want to
continue?

A message in GMT format looks the following way:
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File Options Help

}Search in Andy Kort

& |

| Browse |

=-[]4¥ Maibox Database edb
i1-[] 59 Alex Clark
(159 Andrew Wit
2-[]59 Andy Kort
-[]E2 Calendar (439)
D H Contacts (44)
-.[JCa Deleted tems (2¢)
[ Drafts (0)

§ Subject From

g In itsnature, it is arbitrary an... Kyle Pakerman
It is my lady mother. Itismy... Juliet Capulet
Butthat it might not appeart... John

Do you persuade yourselft... Andy Kort

It wasall eloquence, and ge... Tim Goodler
Alas, the heavy basketwhic... Alex Clark

To

Andrew Wait; Richard; John; Dalia; Ro...
Romeo Montague; Richard; Dalia; Mic...
Romeo Montague; Andy Kort; Robert ...

Susane Tyler; Andy Kort; Juliet Capulet...
Dalia; Tim Goodler; Robert Rise: Susa...

Dalia; Kyle Pakerman; Michael; Susan...

Wednesday, 12 Mar 201+
Wednesday, 12 Mar 201
Wednesday, 12 Mar 201+
Wednesday, 12 Mar 201+
Wednesday, 12 Mar 201
Wednesday, 12 Mar 201:

R[] rbox (1.026)

] @ Joumal (27)

-[]23 Junk Email (0)
[ Notes (40)

Noone, even there, could li... Romeo Montague  Brian; Alex Clark: Richard; Romeo Mon... Wednesday, 12 Mar 201+
Stephen Brice readthe ne...  Luise Alex Clark; John; Tim Goodler; Michael... Wednesday, 12 Mar 201+
Give me some light! Give m... Michael Romeo Montague; Richard; Andrew W... Wednesday, 12 Mar 201+

[ Outbox (0)

CIca Sent tems (0)
[ Tasks (47)
2] Brian

It were good, therefore that ... Andy Kort
The riders could be heard)l... Andrew Wait
The sinewand heart of man... Susane Tyler

~ DoooooJoooooo o
wm&&&mimmmmmm?
(<=1~ [« =1~ lc: [~

Romeo Montague; Andrew Wait; Kyle ...
Susane Tyler; Maria Woods; Romeo M...
Brian; Juliet Capulet; Andy Kort; Robert...

Wednesday, 12 Mar 201«

Wednesday, 12 Mar 201«

Wednesday, 12 Mar 201: v
>

-] Dalia

i-[] @ HealthMailboxadeSae Ae5b54860a1cf0218
-] 59 HealthMailboxbaa8042¢260149a3928ba55
5[] &9 John From: Rudy Raid
t1-[[] 59 Juliet Capulet —
i-[_]9 Kyle Pakeman ! -
-] 9 Maria Woods
i-[] @ Michael There came a rain-sodden night when a mysterious message amived at
-[_]= Personal Archive - HealthMailboxadeSae e the little house in Olive Street. Both arudety and pride were in Mrs.

= g P . |Brice’s eyes as they followed her son out of the door. At Twelfth
ggg ;Z::r:' Archive - HeatthMalboxbaaB42e: Street two men were lounging on the comers, each of whom glanced at

v

He went up a dark and narrow stair into alighted hall with shrouded windows.

X

3 attachment(s):

|| ESSAYS-6.txt, 1.00 KB
|| ESSAYS-47 txt. 1.10 KB
|| ESSAYS-48 txt, 2.31 KB

£
E
E
E
E
E
E
-] Luise
E
E
E
E
E
E

= him listessly as he passed. He went up a dark and namow stairinto a
]“-DgRobeﬂRise R e I - 7 S
< Preview l Properties

Completed

5.6 Showing notification panel

Every program action is accompanied by an appropriate notification for user. Notification panel is disabled by

default, but can be easily enabled by checking Show notification panel in the Options menu.

Show progress dialog
Search within attachments

}Select mailboxes or folders to search

PST encoding >
Incomplete messages » Mailbox Database.edb

: Show deleted it
_W e, Rt 4 C:\Exchange Server Database\Maibox Database.edb
3] Display time > Size: 904 Mb
g M iboxadeJae Ae5b54860a1cf0218267 Datesa/13/2014

= al il e e i .
[ ] 29 HealthMailboxbaa8042e26014%a3928ba554e( VersonEXchange:server 2013
@-[]&9 John 5
-1 29 Juliet Capulet Transaction logs not used.

-[]59 Kyle Pak
ggg h?:e . 22 maiboxes. Select a maibox to display folders.
-] 29 Maria Woods Load time: 00:00:04
@[] &9 Michael ) i
(1-[ ] 29 Personal Archive - HealthMailboxadeSas FeSb!  Display time: Local
f-[ ] 9 Personal Archive - HealthMailboxbaa8042e260  PST encoding: Unicode (Microsoft Outiook 2003, 2007, 2010 and 2013)
@-[]&9 Richard Show deleted items: Only non-deleted items
-] £9 Robert Rise Incomplete messages: Hide
-] 9 Romeo Montague Search within attachments: On
-] &9 Rudy Raid
-[_]£9 Susane Tyler

[[]£9 SystemMailbox{adeSae -505-4860-a 1cf-021
@-[_]&39 Tim Goodler

< | Fite info
Completed
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After that user will see additional information about opening file, export results, search results, etc.

File Options Help

; 2 | Search in Andy Kort and 2 more pel ‘
s H A \

| Browse |

-] 29 Alex Clark Mailbox Database.edb

Andy Kort C:\Exchange Server Database\Maibox Database.edb
Brian Size: 904 Mb
9 Do Date: 3/13/2014

=5 HealthisilboxadeSae eSb548608 110218267 \rores ™
[]29 HeahthMaiboxbaaB04262601452a0280a5546( ¢ SON: EXChange Server 2013

e Eg ﬂ: Capuiet Transaction logs not used.

%g m::akemaﬂ 22 mailboxes. Select a maibox to display folders.

-[[]Z9 Maria Woods Load time: 00:00:04
1 [C] &9 Personal Archive - HealthMailboxadeSae eSb!  Display time: Local

[[]£9 Personal Archive - HealthMailboxbaa8042e260 PST encoding: Unicode (Microsoft Outiook 2003, 2007, 2010 and 2013)
[]&9 Richard Show deleted items: Only non-deleted items

]9 Robert Rise Incomplete messages: Hide

[]&9 Romeo Montague Search within attachments: On

[¥]1£9 Rudy Raid
9 Susane Tyler
= SyslemMaiIbcx{adeSaeW-eﬂ)m-ﬂd-Oﬂﬁ
]9 Tim Goodler

& 5| Fileinfo |

11/18/2017 3:17:08 AM] Save time: 0 hour(s) 0 minute(s) 50 second(s)
11/18/2017 3:17:08 AM] Exported 3 mailbox(es), 33 folder(s) and 4,872 message(s) into c:\Recovered\CLIENT-PC\Recovery 001*.pst
11/18/2017 3:16:13 AM] Database load time: 0 hour(s) 0 minute(s) 4 second(s)

elected: 3 mailbox(es

5.7 Finding and selecting messages, folders and mailboxes

Granular Restore for Microsoft Exchange and SQL provides two mutually complementary modes of finding,

previewing and selecting items: browsing the mailbox tree and search. Using these, it is possible to efficiently

form a set of items for subsequent export, including the necessary ones and excluding ones to be skipped.

A newly opened database is shown in the Browse mode.

ry >

File Options Help

/ ’:‘7 H i iSeIed mailboxes or folders to search [ yel
‘ Browse 7‘ - -
=010
@[] =9 Alex Clark Mailbox Database.edb
@-[]£9 Andrew Wait
&[] 29 Andy Kort C:\Exchange Server Database\Maibox Database.edb
LISy feen Size: 904 Mb
ggg Dl s s i sh54600 1ciatazs DS 3/13/2014
. Healtt T
]9 HealthMailboxbaa8042e260149a328ba554e e Exenangeseer 0l
L& John Transaction logs not used.

@[] 9 Juliet Capulet
@-[_]£9 Kyle Pakerman

5159 Luise 22 maiboxes. Select a mailbox to display folders.
- [129 Maria Woods Load time: 00:00:04
-] &9 Michael

[ 9 Personal Archive - HealthMaiboxadeSae #e5b!  Display time: Local
(1-[ ]9 Personal Archive - HealthMailboxbaa8042e260  PST encoding: Unicode (Microsoft Outiook 2003, 2007, 2010 and 2013)

@-[]£9 Richard Show deleted items: Only non-deleted items
@[] Robert Rise Incomplete messages: Hide

#-[_]£9 Romeo Montague Search within attachments: On

@-[]&3 Rudy Raid

-[]&9 Susane Tyler
-[_]£9 SystemMailbox{adeSae H-5b5-4860-a1cf-021
-[]&39 Tim Goodler

s > || Fileinfo |

Completed B |
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5.8

Browse mode shows mail store in a tree-like structure and allows browsing folders and previewing individual

Browsing mail store tree

items.

This mode is best for navigating to specific mailboxes, folders and messages when it is precisely known what
data needs to be extracted.

For example, a user may ask to restore a specific message from a known folder. Expand his or her mailbox in
the tree, select the folder, find and click the item. All available properties and information about the item will

be displayed in the Preview window to the right of the tree.

File  Options

=

Browse

Help

| Search in Andy Kort

=-[_]43 Maibox Database edb
-] 59 Alex Clark
159 Andrew Wait
2-[]£9 Andy Kort

[C]124 Calendar (429)

g Subject From
g In itsnature, it is arbitrary an...
It is my lady mother. Itis my...
Butthat it might not appeart...
Do you persuade yourself t...
It wasall eloquence, and ge...
Alas, the heavy basketwhic...

Kyle Pakerman
Juliet Capulet
John

Andy Kort

Tim Goodler
Alex Clark

OooooOooo

..[J3 Drafts (0)
O
1.8 Joumal (27)

- []Z@ Junk Email (0)
[Ji. Notes (40)
[ Outbox (0)
[JEa Sent tems (0)
[ Tasks (47)

-] 59 Brian

[ ]9 Dalia

Romeo Montague
Luise

Michael

Andy Kort
Andrew Wait
Susane Tyler

Noone, even there. could li...
Stephen Brice read the ne...
Give me some light! Give m...
It were good, therefore that ...
The riders could be heard ...
The sinewand heart of man...

m&u&m&ﬂ&mmtuu%

0Oooooo

g
g
[ [He went up a dark and nar._[Rudy Raid_____|
g
g
!
g

To

Andrew Wait; Richard; John; Dalia; Ro...
Romeo Montague; Richard; Dalia; Mic...
Romeo Montague; Andy Kort; Robert ...

Susane Tyler; Andy Kort: Juliet Capulet...
Dalia; Tim Goodler; Robert Rise; Susa...

Dalia; Kyle Pakemman; Michael; Susan...

Brian; Michael; Richard; Dalia; Luise; T...
Brian; Alex Clark; Richard; Romeo Mon...
Alex Clark; John; Tim Goodler; Michael...
Romeo Montague; Richard; Andrew W...
Romeo Montague; Andrew Wait; Kyle ...
Susane Tyler; Maria Woods; Romeo M...
Brian; Juliet Capulet; Andy Kort; Robert...

Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2 v
>

[

[ -
@#-[]£9 HealthMailboxadeJae He5b54860a1cf0218
[#-[ ]9 HealthMailboxbaa8042e260149aa928ba55
@-[]&9 John

-[]59 Juliet Capulet

- ]9 Kyle Pakeman

[]Dé Luise

@-[_] 9 Maria Woods

-] &9 Michael

(-] &9 Personal Archive - HealthMailboxadeSae e
@] @ Personal Archive - HealthMailboxbaa8042e:
[]DQ Richard

@[] Robert Rise

(fic went up a dark and narrow stair into a‘lgﬁted hall with shrouded windows.

v

3 attachment(s):

|| ESSAYS-6.txt, 1.00 KB
|| ESSAYS-47 txt. 1.10 KB
| ESSAYS-48.1xt, 2.31 KB

From: Rudy Raid

Wednesday, March 12, 2014 10:29:00 AM UTC-07:00
“Brian” <Brian@no-such-email.com>, "Michael” <Michael@no-such-email.com...

Sent:
To:

ere came a rain-sodden night when a mysterious message amived at
e little house in Olive Street. Both arxiety and pride were in Mrs.

ice’s eyes as they followed her son out of the door. At Twelfth
treet two men were lounging on the comers, each of whom glanced at
im listessly as he passed. He went up a dark and namow stair into a

PP 2 i i SN A~ S o A c .

< Preview | Properties |

Completed

There is a check box next to the message. Check it to mark the message for export.

Continue to mark other items, folders and mailboxes for export in a similar way.
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File

2l

‘Browsel

Options  Help

Search in Andy Kort

=- E] ¥ Mailbox Database edb

[ ]2 Calendar (429)
[ 8] Cortacts (44)
-[[]3 Deleted ftems (24)
.[Ja Drafts (0)
O[] inbos (1.024)
-] 8 Joumal 27)
-[JCa Junk Email (0)
.[J Notes (40)
[ Outbox (0)
.. Sent tems (0)
[ ] A Tasks (47)
@-[]£9 Brian

@[] Dalia

[]-»D@ HealthMailboxadeae e 5b54860a1cf0218
-[_] 9 HealthMailboxbaa8042e26014%aa928ba55
@-[]£9 John

-] 9 Juliet Capulet

@-[_]£9 Kyle Pakeman

-] Luise
£
[
[E
[
£
[

-] 9 Maria Woods

o[ 29 Michael

+-[_] 9 Personal Archive - HealthMailboxade Sae e
+-[_] 9 Personal Archive - HealthMailboxbaa8042e:
2 [] 29 Richard

[ ]9 Robert Rise

<

odeder ®
&m&mmmm&ﬂ&ﬂm&

To Created

Andrew Wait; Richard; John; Dalia; Ro... Wednesday, March 12, 2
Romeo Montague; Richard; Dalia; Mic... Wednacday March 12, 2

From

Kyle Pakeman
Jl.liet Capulet

{ Subject
g In itsnature, it is arbitrary an..
It is my lady mother. ltismy...

g
@

| [Butthat t might not sppeart._Lobn | Romeo Montague: Andy Kott: Robert __[Wednesday. March 12. 2
Andy Kort
Dalia; Tim Goodler; Robert Rise; Susa.
Alas, the heavy basketwhic...

L |
g
G He went up a dark and narr...
g
g
g
g

Susane Tyler; Pndy Kort; Julvet Capulet... Wedneeday March 12 2
Dalia; Kyle Pakerman; Michael; Susan... Wednesday. March 12, 2
Brian; Michael; Richard; Dalia; Luise; T... Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12,2 v
>

X

g Do you persuade yourselft

Alex Claric
Rudy Raid
Romeo Montague  Brian; Alex Clark; Richard; Romeo Mon...

Luise Alex Clark; John; Tim Goodler; Michael...

Michael Romeo Montague; Richard; Andrew W...
Andy Kort Romeo Montague; Andrew Wait; Kyle ...
Andrew Wait Susane Tyler; Maria Woods; Romeo M...
Susane Tyler Brian; Juliet Capulet; Andy Kort; Robert...

Noone, even there. could ...
Stephen Brice read the ne...
Give me some light! Give m...
It were good, therefore that ...
The riders could be heard ...
The sinewand heart of man...

1 ol
4

= RRRIE

and noble thought." It wasall
N

and g

Tim Goodler

Wednesday, March 12, 2014 10:29:00 AM UTC-07:00

“Dalia” <Dalia@no-such-email.com>, “Tim Goodler” <Tim.Goodler@no-such-email.com>, "Robert Rise...
"Dalia” <Dalia@no-such-email.com>, “Tim Goodler” <Tim.Goodler@no-such-email.com>, "Robert Rise...

I
-]
3

To:
Cc:

The Cure frowned and continued: ""You look on yonder buming walls,” he
said, 'and wonder when they will rise again on this hill made sacred

by the burial of your beloved, by the christening of your children, the
marmiages which have given vou hapov homes. and the ts which
[ Preview [ Properties J

Completed

Selected: 1,022 item(s) in 1 mailbox{es)

Use filtering feature for better browsing the list of items in a folder.

Enable filtering by pressing Ctrl+F keys. A special panel will appear in the right part of the program window.

File

& |

‘Brcwse‘

Options  Help

o

ESearch in Andy Kot

¥ Mailbox Database edb

. []Lf Calendar (439)
[ ] =] Contacts (44)
.. Deleted kems (24)
-3 Drafts (0)

B o (1020 |
-.[] @ Joumal (27)
[ Junk Email (0)
- Notes (40)
-3 Outbox (0)
[ Sent tems (0)
]9 Tasks (47)
[].,.D§ Brian

@[] £ Dalia

-[_]£9 HealthMailboxade 9ae e 5b54860a 1cf0218
[J»‘[‘__Iéﬁ HealthMailboxbaa8042e2601492a528ba55
-] &9 John

-] &5 Juliet Capulet

(]9 Kyle Pakerman

[ ]9 Luise
£
E
£
[
[
[

o-[_] 9 Maria Woods

-] &9 Michael

+-[_] =9 Personal Archive - HealthMailboxade 9ae e
+-[_] 9 Personal Archive - HealthMailboxbaa8042e!

[ ]9 Richard

i1-[]=9 Robert Rise

<

[J Type  Subject From To
|:| \Ei g Privatebankers in London g. Tim Goodler Romeo Montague; Alex Clark; Susane ..
Schools have no exclusive... .lulnet Capulet Rudy Raid: Dalia; Romeo Montague; ..

I:l“- This relaxation in theexclusi Maria Woods; Susane Tyler. Andy Kon

Created i ‘
. Wednesday, March 12, 2014
Wednesday, March 12, 2014

Wednesday, March 12, 2014

priv Where: Al Filter: on [] Select fitered items

This relaxation in theexclusive privileges of the pany. is probably the principal...

From: Dalia

Wednesday, March 12, 2014 10:21:00 AM UTC-07:00
“Maria Woods™ <Maria. Woods@no-such-email.com>, "Susane Tyler” <Susane.Tyler@no-such-email.com...

Sent:
To:

The Dutch settlements in the West, as well as those in the East Indies,
were originally put under the govemment of an exclusive company. The
progress of some of them, therefore, though it has been considerable in
comparison with that of almost any country that has been long peopled
and establlshed has been Iangud and s|ow in companson wih that of

v
] Prevlew ‘ Properhee ’

Completed
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Use search in preview feature for quick find text in item preview.

Enable search in preview by pressing Ctrl+D keys after opening preview of item. A special panel will appearin
the right part of the program window.

File Options Help
Search in Andy Kort

Browse
=-[] 43 Maibox Database.edb
-[159 Alex Clark
#-[]£9 Andrew Wait
2159 Andy Kot
[ ]2 Calendar (439)
..[ ] 8 Contacts (44)
[ ]2 Deleted ltems (24)
--[_]Z@ Drafts (0)
B o (1020 |
[ ] @l Joumal (27)
~[JZ3@ Junk Email (0)
[ ] Notes (40)
[ ]z Outbox (0)
[ ]z Sent tems (0)
-[] & Tasks (47)
@-[_]&39 Bran
@-[_]&39 Dalia
-[] 59 HealthMailboxadeSae FeSb54860alcf0218 | |light 7‘ i find |
- [:lé HealthMailboxbaa8042e26014%aa328ba55
@-[]£9 John
([ &9 Juliet Capulet
@-[1£9 Kyle Pakerman From: Michael 7 attachment(s):
e[ 59 Luise ESSAYS-2.txt, 526 bytes
[
[
[
£
[
£

g Subject From To Created o)
[.] In itsnature, it is arbitrary an... Kyle Pakerman Andrew Wait; Richard; John; Dalia; Ro... Wednesday, March 12, 2
It is my lady mother. ltismy... Juliet Capulet Romeo Montague; Richard; Dalia; Mic... Wednesday, March 12, 2
Butthat it might not appeart... John Romeo Montague; Andy Kort; Robert ... Wednesday, March 12, 2
Do you persuade yourselft... Andy Kort Susane Tyler; Andy Kort; Juliet Capulet... Wednesday, March 12, 2
It wasall eloquence, and ge... Tim Goodler Dalia; Tim Goodler; Robert Rise; Susa... Wednesday, March 12, 2
Alas, the heavy basketwhic... Alex Clark Dalia; Kyle Pakerman; Michael; Susan... Wednesday, March 12, 2
He went up a dark and narr... Rudy Raid Brian; Michael: Richard: Dalia; Luise; T... Wednesday, March 12, 2
Noone, even there, could li... Romeo Montague  Brian; Alex Clark: Richard; Romeo Mon... Wednesday, March 12, 2
Stephen Brice read the ne...  Luise Alex Clark; John; Tim Goodler; Michael... Wednesday, March 12, 2

g
g
g
0
[ { [Give me some light! Givem.._ [ Michael ______[Romeo Mortague: Richard; Andrew W._.| Wednesday. March 12.2
g
{

>

e DDDDDDDDDDDDD O

It were good, therefore that ... Andy Kort Romeo Montague; Andrew Wait; Kyle ... Wednesday, March 12, 2
The riders could be heard ... Andrew Wait Susane Tyler; Maria Woods; Romeo M... Wednesday, March 12, 2
The sinewand heart of man... Susane Tyler Brian; Juliet Capulet; Andy Kort; Robert... Wednesday, March 12, 2 v

LLLHLLLLLLLEL§

>

i1-[] 59 Maria Woods Sent  Wednesday. March 12, 2014 10:29:00 AM UTC-07:00 ey

[[]£39 Michael To: "Romeo Montague™ <Romeo.Montague@no-such-email.com>, "Richard...

ESSAYS-43.txt, 760 bytes

=
5 Personal Archive - HealthMailboxadeSae e || ESSAYS-10.txt, 1.20 KB
=
| ESSAYS-47ixt, 1.10KB

9 Richard The story is extant, and written in very choice lalian. You
,-:? Robert Rise chall e22 annn haw the murtherer nets the Inve of Gonzann's wife

< Preview | Properties

|2 E et

O
% £ Personal Archive - HealthMailboxbaa8042e Ham. He poisons him i'th’ garden for's estate. His name’s Gonzago.
|

Completed

Tip
Each individaul item, folder and mailbox has a check box next to it. Using these check boxes, it is possible
to select as many or as few items for export as necessary.
To export an entire:
e Mail store, mark the root check box with the mail store name.
e Mailbox, mark the check box next to the mailbox in the tree.

e Folder, mark the check box next to the desired folder.

5.9 Using search

The search in the main window provides the ability to search single or multiple mailboxes and perform actions
on the search results.

The best application of search mode is when the location and/or number of items to extract is not known
exactly. Using keyword search, it is possible to narrow down on specific messages, folders and mailboxes. The
quickest way to get search results is clicking on a particular mailbox, entering some keywords in the Search
field and clicking the button Start search.

40
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Search results will be displayed on a separate tab.

File  Options

& | S

[ Browse | Search: awaits (1.016) X |

Help

Search in user-defined locations: wait

[ERMIY] Search: «wait» (1.016)

=[] £9 AlexClark (1,016)

[ &l Joumal (3)
CJo Notes (4)
“e[] A Tasks (2)

From

Rudy Raid
Andrew Wait
Brian

Andrew Wait
Maria Woods
Andy Kort
Andrew Wait
John

Dalia
Andrew Wait
Maria Woods
Juliet Capulet
Andrew Wait
Susane Tyler
Andrew Wait
Alex Clark
Susane Tyler
Brian
Andrew Wait
Susane Tyler
Robert Rise
Dalia
Richard
Rudy Raid

Location
\Alex Clark\Calendar
\Alex Clark\Calendar
\Alex Clark\Calendar
\Alex Clark\Calendar
\Alex Clark\Calendar
\Alex Clark\Calendar
\Alex Clark\Calendar
“Alex Clark\Calendar
\Alex Clark\Calendar
\Alex Clark\Calendar
\Alex Clark\Calendar
\Alex Clark\Calendar
\Alex Clark\Calendar
“Alex Clark\Calendar
\Alex Clark'\Calendar
\Alex Clark\Calendar
\Alex Clark\Calendar
\Alex Clark\Calendar
\Alex Clark\Calendar
\Alex Clark\Calendar
\Alex Clark\Calendar
\Alex Clark\Calendar
\Alex Clark\Calendar
\Alex Clark\Calendar

Subject
The faceis
But the thing
When the

I have

He had taken
LADY FAULCONBRIDGE.

After
Her father
Brinsmade, lifting the

Mon. Mon. Mon.
Originally,

| called him

She gathered

The maintenance of
Chaudiere had
Beside

Break off thy

How frequently

She was going

= Al00000000000ooooooooooooo o
EEEEEEEEEEEEEEEEEEEEEEEE §

4 |Page1of11| b MO

To

Michael; Juliet Capulet; Kyle Pakerman...
Susane Tyler; Alex Clark; Michael; Rud...

Andrew Wait

Andy Kort; Maria Woods; Juliet Capulet...

John; Alex Clark; Susane Tyler; Dalia

Alex Clark; Rudy Raid; Maria Woods; ...
John; Michael; Juliet Capulet; Rudy Ra...
Alex Clark; Maria Woods; Susane Tyler...
Brian; Robert Rise; Michael; Rudy Rai...

Juliet Capulet; Luise; John
Andy Kort; Luise; Juliet Capulet

Susane Tyler; Alex Clark; Kyle Pakem...
Andy Kort; John; Tim Goodler; Susane ...
Andrew Wait; Alex Clark: Robert Rise: ...
Susane Tyler; Brian; Alex Clark; Rome...

Rudy Raid; Richard; John; Kyle Paker...

Maria Woods; Andy Kort; Andrew Wait...
Alex Clark; Tim Goodler; John; Romeo ...

Kyle Pakerman

Andrew Wait; Andy Kort; Alex Clark; M...
Richard; Andy Kort; Maria Woods; Sus...
Alex Clark; Rudy Raid; Luise: Tim Goo...
Maria Woods; Michael; Robert Rise: R...
John; Susane Tyler; Luise: Romeo Mo..:

v
>

Search complete, 1,016 matches

messages per page

If a user knows exactly in what mailbox or folder the data is located, using Search in mailbox option will speed

up the search.

Right-click on a folder/a mailbox will open a context menu.

File Options Help
(7 H &
| Browse |

ESeled mailboxes or folders to search

12|

[ =[] 43 Mailbox Database edb
[ ] 59 Alex Clark

9 HealthMailboxadeJae Ae5054860a1cf0218267
9 HealthMailboxbaa8042e260149aa928ba554e(

> e
= J Search in mailbox

ER
éLL
EL
EYL

= Personal Archive - HealthMailboxade ae e 5b
=9 Personal Archive - HealthMailboxbaa8042e260
9 Richard

5 Robett Rise

ﬁ Romeo Montague
5 Rudy Raid

Collapse all mailboxes

Clear all selections

O § SystemMailbox{ade Sae F-e5b5-4860-a1cf-021
@-[_]£&9 Tim Goodler

< >

Mailbox Database.edb

C:\Exchange Server Database\Maibox Database.edb
Size: 904 Mb

Date: 3/13/2014

Version: Exchange Server 2013

Transaction logs not used.

22 maiboxes. Select a maibox to display folders.
Load time: 00:00:04

Display time: Local

PST encoding: Unicode (Microsoft Outiook 2003, 2007, 2010 and 2013)
Show deleted items: Only non-deleted items

Incomplete messages: Hide

Search within attachments: On

| Fileinfo |

Completed
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By clicking on this menu advanced mode of search dialog will be opened and Search in field will be filled with
the selected mailbox/folder.

Fill in necessary search parameters and start the search.
For more precise searches click on the Search field, drop-down list of all search fields will appear:

e Search in - specifies mailbox(es)\folder(s) to search in. Default: entire database. If you select one or
more Search in check boxes, but specify no additional search criteria, the utility will return all items
from the selected folder(s).

=9
w-[] &) Alex Clark
&[] Andrew Wait
-[V] ) Andy Kort
=[] &9 Brian

[]E4 Calendar (444)
] Cortacts (44)

[(Jw Notes (40)

] Outbox (0)

[Tl Sent ttems (D)

[ Tasks (47)

&[] Dalia
[]DQ‘ HealthMailboxade 9ae Fe5b54860a1cf021826768730
[]DQ’“ HealthMailboxbaa8042¢260149aa328ba554e0059d7d3
&-[]&9 John

&-[ ]9 Juliet Capulet
[

[

[

[

[

i-[ ] Kyle Pakerman

0-[ ] Luise

i-[_] ) Maria Woods

7-[_] ) Michael

vl 125 Personal Archive - HealthMailboxade Sae Fe5b54860a1cf021826 768790
["] Include mailboxes that are expanded, have items selected or were searched before

[ oK

e Has words — search for mail store items that have words or phrases entered in the field.

e Doesn’t have — search for mail store items that do not have words or phrases entered in the field.
e Has attachments — search for items with attachments.

e From —search for keywords in the From field.

e To-—search for keywords in the To field.

e Subject —search for keywords in the subject.

e Date range — set specific date range if known. It is obligatory to set both the beginning and the end of
the desired time period.
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The outcomes of a search can be:

1.

The program was able to find items (1) that corresponds to specified search parameters (2). The user
can select separate items or mark search results for recovery.

Clicking an item in the search results tab will open the item preview. Selecting item(s) in search results
will make their recovery possible.

File Options Help

/ 2 HJ—:I!I & Eéarch in user-defined locations: from:{Andrew) has:attachment wait
/ B §

= o i Alex Clark; Andrew Watt; Andy Kort; Brian
| Browse | Search: «from:(Andrew) has:at...» (96) X 1\) [?ﬂ,

2 MKy ) oearchi: diom {Andiew) hasat...» (Jb)

=[] £9 Alex Clark (20)
¢ [ JZ3 Inbox (20)

=[] Andrew Wait (43)

i L[] Calendar (25)
[Ja Inbox (18)
149 Andy Kott (19)
i L[] Inbox (19)

=-[]£9 Brian (14)

L@ Inbox (14)

Location
\Andy Kort\Inbox
\Alex Clarkc\Inbax Include mailboxes that are expanded, have items selected or were
\Andrew Wait\Inbox searched before
\Brian\Inbox
\ndy Kort\Inbox
\Andy Kort\Inbox Doesnt have:
\Andrew Wait\Inbox
\Alex Clark\Inbox )
\Andrew Wait\Inbox ;| Andrew
\Alex Clark\Inbox E
\Brian\Inbox
‘Alex Clark\Inbox
\Alex Clark\Inbox
\ndy Kort\Inbox
\ndy Kort\Inbox
\Andrew Wait\Inbox
\Alex Clark\Inbox 11l drop the paper- ,sha... . Rol Se;
\Andrew Wait\Inbox Andrew Wat  Andy Kort; Romeo Montague; Mic
\Andy Kort\Inbox Andrew Wait  Andy Kort; Romeo Montague; Mic
“Andy Kort\Inbox Alone she was in thehouse-her brother... Andrew Wait  Kyle Pakeman; John; Susane Tyl
\Andrew Wait\Inbox Alone she was in thehouse-her brother... Andrew Wait  Kyle Pakeman; John; Susane Tyl
\Andrew Wait\Inbox Dan still owns it. Dan still owns it. Dan ... Andrew Wait  Robert Rise; John; Kyle Pakermar
\Alex Clark\Inbox Dan still owns it. Dan still owns it. Dan ... Andrew Wait  Robert Rise; John; Kyle Pakemar
\Brian\Inbox Dan still owns it. Dan still owns it. Dan ... Andrew Wait ~ Robert Rise; John; Kyle Pakemnar o,
>

It 4 |Page 1 of1 | b M O mssages per page

Has words: | wait

Has attachments

[] Type
[ =
[1 =
O =
[1 =
[1 =
0 =
[1 =
[1 =
[1 =
0 =
1 =
[1 =
0 =
[1 =
1 =
0 =
1 =
[1 =
0 =
1 =
0O =
O =
O =
O =

Search complete, 96 matches

Counters of found elements are automatically updated or can be updated manually by clicking on the
Refresh button. If any folder is selected and the program has found new elements in it, then the
following value will be shown: previous (value, when we selected the folder) value of a counter + count
(in green) of newly found elements, which will be updated in real-time.
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File  Options Help

{Search in user-defined locations: wait

Location
\Alex Clark \Inbox
\Alex Clark\Inbox
\Alex Clark \Inbox
\Alex Clark\Inbox
\Alex Clark\Inbox
\Alex Clark\Inbox
\Alex Clark\Inbox
\Alex Clark\Inbox
\Alex Clark\Inbox
\Alex Clark\Inbox
\Alex Clark\Inbox
\Alex Clark\Inbox
\Alex Clark\Inbox
\Alex Clark\Inbox
\Alex Clark\Inbox
\Alex Clark\Inbox
\Alex Clark \Inbox

Subject From To

How goes the world, sir, now? How go... Andrew Wait Michael; Alex Clark; Susar
Nature then becomesto him the measu... Andrew Wait Rudy Raid; Michael; Alex |
For neary a month he had tramped ov... Kyle Pakeman Brian; Susane Tyler; John;
This high price, indeed, seems to have... Alex Clark Romeo Montague:; Richan
Uncle, for God's sake, speak comforta... Brian Kyle Pakeman; Michael; f
For | have swom deep oaths of thy de... Andrew Wait Luise

The otherthat you do not peremptorily ... Richard Maria Woods; Andrew Wz
In the course of ages, such circumstan... Maria Woods John; Andrew Wait; Rome
Blow, you bandsmen on the hunicane ... John Alex Clark; Romeo Montag
Out in the suburbs, at the country hous... Andrew Wait Andy Kort; John

Neither his daughter, if we judge by ma... Rudy Raid Romeo Montague: Brian; |
Thanks, and good night to the Greeks... Maria Woods Romeo Montague:; Alex Cl
Now have | paid my vow unto his soul;  Andrew Wait Richard; Romeo Montagur
It released something. It released some... Susane Tyler Alex Clark; Robert Rise; Lt
In order, however, to obtain this relativ... Rudy Raid Michael; Susane Tyler; Rc
To general fiths  Convert, o'th'instant, Andrew Wait Andrew Wait; Brian; Susar
And for 3 woman wert thou first create... Dalia Luise; Rudy Raid; John; M
“Alex Clark\Inbox And as with religion amongst us at that ... Andrew Wait Andy Kort; Maria Woods; «
“Alex Clark\Inbox Open wagons and conestogas and car... John John; Dalia; Luise; Susane
“Alex Clark\Inbox When the war came, their system conti... Andrew Wait Brian; Alex Clark; Andy Ko
\Alex Clark\Inbox But since she pricked thee out for wom... Rudy Raid Michael; Robert Rise; Rict
\Alex Clark \Inbox It is a distinction of species. ltisa Andy Kort Michael; Robert Rise: Rict
“Alex Clark\Inbox It called from the far north-the northof ...  Tim Goodler Luise

‘Alex Clark\Inbox It was, besides, a foreign manufacture,... Andrew Wait Romeo Montague: Dalia: |

[ ]£9 AexClark (1,0
114 Calendar (278)

- []5 Andrew Wait (1.473)
[]i1 Calendar (421)

[ ] Calendar (278)
O J Contacts (3)

=[] Brian (363)
T ]ttt Calendar (273)

= N000000000000000oooooooo o
‘&mmm&&&&&m&m&&&&&mmm&&m&§'

>
4 | Page 1 of5* | b Pl O messages per page
Search complete, 4,428 matches H

Words and phrases which match the search query are highlighted in the preview, which helps to easily
identify where the match was found.

File Options Help

,.{ ”'7 H -~ {Search in user-defined locations: from:{Andrew Wait) wait

| Browse | Search: afrom:{Andrew Wait) wits (108) X |

= D [) Search: drom:{Andrew Wait) wait» (109)
[[]&3 Andrew Wait (109)

Location Subject From To

\Andrew Wait\Inbox Will it not be received, When we hav... Andrew Wait  Juliet Capulet; Andrew Wait;
\Andrew Wait\Inbox Exeunt FAIRIES Exeunt FAIRIES Andrew Wait  Maria Woods; Juliet Capulet;
\Andrew Wait\Inbox Conceming the bounds of unity; the tru... Andrew Wait  Alex Clark; Andrew Wait; Luis
\Andrew Wait\Inbox Andrew Wait  Andy Kort; Romeo Montague
\Andrew Wait\Inbox A particular country, in the same Andrew Wait  Robert Rise; Andrew Wait; Al
“\Andrew Wait\Inbox 11l drop the paper- Sweet leaves, sha... Andrew Wait  Andy Kort; Robert Rise; Rudy
\Andrew Wait\Inbox They were getting kind of interested. T... Andrew Wait  Rudy Raid: Andrew Watt;: Ro
\Andrew Wait\Inbox SHALLOW. SHALLOW. SHALLO.. Andrew Wait Alex Clark; Juliet Capulet; Lui:
\Andrew Wait\Inbox Thesubscribers to a new loan, who me... Andrew Wait  Robert Rise; Maria Woods; L
| = [\Andew Waithinbox [ 0] [Andrew Wai_|John: Michae!; Luise: Susand
\Andrew Wait\Inbox Let it be vituous to be obstinate. Letit ~ Andrew Wait  Alex Clark; Andrew Wait; Luis
“Andrew Wait\Inbox i Hisgamments hung in tatters; his boots ... Andrew Wait  Kyle Pakeman; Maria Wood:

DNNEEEENE 3

"IDDDDDDDDDDDD O

From} Andrew Wait 6 attachment{s):

[aZ] DR gif, 275 KB
[aZ]DRSP.gif, 29.7 KB

[aZ] DRSP.gif, 29.7 KB

|| ESSAYS-3.xt, 1.93 KB

Whether taxes upon the necessaries of life, such as those in Great || ESSAYS-10.txt, 1.20 KB
Britain upon soap, salt, leather, candles, etc. necessarily raise the Y
ine of lahy uenthy that of all other commocties. | shal B ESSAYS- 1164 461KB
Preview P?ndm:;er

ay. March 12, 2014 10:25:00 AM UTC-07:00
“John" <John@no-such-email.com>, "Michael” <Michael@no-such-email.com...
“John™ <John@no-such-email.com?, "Michael" <Michael@no-such-email.com...

4 | Page 1 of2| | 2 L] messages per page
Search complete, 109 matches s
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2. The search didn't match any items. Review search parameters and run another search.

To delete temporary data, generated by Granular Restore for Microsoft Exchange and SQL, go to the

File menu and click Delete saved search indexes and logs.

-
File | Options Help

Open file...
Recent

Closefile

Search for files to open...

Export selected items into PST...

Cancel current operation

Open log folder

Reload database using transaction logs

Export into original Exchange mailbox...

|Search in userdefined locations: wait
|

—

Location
\Alex Clark\Inbox
\Alex Clark\Inbox
\Alex Clark\Inbox
\Alex Clark\Inbox
\Alex Clark\Inbox
\Alex Clark\Inbox
\Alex Clark\Inbox
\Alex Clark\Inbox
\Alex Clark\Inbox
\Alex Clark\Inbox

Tr==y ey
[ Deleted tems (26)
Clca Inbox (1,008)
1.8 Joumal (3)

[[J. Notes (6)

[ Tasks (5)
&[5 Andy Kot (576)
T2 Calendar (27)

--[]Z@ Inbox (663)
-] 8l Joumal (4)

[1 ] Tasks (3)

&[] &9 Brian (363)

[ _]44] Calendar {273)

[ ] <] Contacts (3)
[]3 Deleted tems (14)

Search complete, 4,428 matches

Note

- A O00000000000000

\Alex Clark\Inbox
\Alex Clark\Inbox
\Alex Clark\Inbox
\Alex Clark\Inbox
\Alex Clark\Inbox
\Alex Clark\Inbox
\Alex Clark\Inbox
\Alex Clark\Inbox
\Alex Clark\Inbox
\Alex Clark\Inbox
\Alex Clark\Inbox
\Alex Clark\Inbox
\lex Clark\Inbox
\Alex Clark\Inbox

 EEENDINEEEEEEEENEEEEEEEEE §

{|Page1of4' b MO

In the course of ages, such circumstan...
Blow, you bandsmen on the humicane ...

Out in the suburbs, at the country hous...
Neither his daughter, if we judge by ma...

Thanks, and good night to the Greeks'...
The king hath granted every article:
Now have | paid my vow unto his soul;

It released something. |t released some...

In order, however, to obtain this relativ...
To whom, with all submission, on myk...
To general fiths Convert, o'th’instant,
And for a woman wert thou first create....

And as with religion amongst us at that ...
Open wagons and conestogas and car...
When the war came, their system conti...
But since she pricked thee out for wom...

It is a distinction of species. ltisa
It called from the far north-the northof ..
It was, besides, a foreign manufacture....

Then, again, a poet or poem may coun...

| can give youenough for any woman’s...
Past cure | am, now reason is past car...
That members of the laboring class, at ...

From

Michael
Maria Woods
John
Andrew Wait
Rudy Raid
Maria Woods
Michael
Andrew Wait
Susane Tyler
Rudy Raid
Brian
Andrew Wait
Dalia
Andrew Wait
John
Andrew Wait
Rudy Raid
Andy Kort
Tim Goodler
Andrew Wait
Rudy Raid
Maria Woods
Dalia
Andrew Wait

To
Alex Clark; Rudy Raid; Mic
John; Andrew Wait; Rome
Alex Clark; Romeo Montag
Andy Kort; John
Romeo Montague; Brian; |
Romeo Montague; Alex Cl
Robert Rise; Brian; Dalia;
Richard; Romeo Montague
Alex Clark; Robert Rise; Lt
Michael; Susane Tyler; Rc
Rudy Raid; Michael; Tim C
Andrew Watt; Brian; Susar
Luise; Rudy Raid; John; N
Andy Kort; Maria Woods: .
John; Dalia; Luise; Susane
Brian; Alex Clark; Andy Ko
Michael; Robert Rise; Rict
Michael; Robert Rise; Rict
Luise
Romeo Montague; Dalia; |
Andrew Wait; Maria Wooc
Tim Goodler; Maria Woods
Brian; Tim Goodler; Alex C
Andrew Watt; Tim Goodler ,
>

messages per page

Next search in the same folder/mailbox will be almost instant (only if saved search indexes and logs

haven’t just been deleted).

Note

Search with empty query is not available.

Note

Asterisk (“*’) is added to all words in search fields by default. This allows to find not only specified words

but also their word forms. Use quotes (

" u

) to search for an exact phrase.
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Advanced search

Advanced search uses symbols and operators in queries. These operators allow you to find what you're looking

for quickly and accurately.

To use advanced search enter operators and their values into the Search field (1).

File Options Help

Browse |

=09
-] &9 Alex Clark
-9 Andrew Wait
-] Andy Kot
L1259 Bran
- ]9 Dalia
Dg HealthMailboxade ae e 5b54860a 1cf0218267
+ Dg HealthMailboxbaa8042e260149aa528ba554e(
&-[]&9 John
-] 29 Juliet Capulet
-[_]£9 Kyle Pakeman
o 0129 e
&1-[] &9 Maria Woods
-] Michael
(-] £9 Personal Archive - HealthMailboxadeSae Ae5b!
(#-[ ]9 Personal Archive - HealthMailboxbaa8042¢260
#-[]&9 Richard
@#-[] &9 Robert Rise
-] 9 Romeo Montague
- []29 Rudy Raid
@[] &9 Susane Tyler
& g SystemMailbox{adeSae F-e5b5-4860-a1cf-021
-[]&9 Tim Goodler

< >||

‘aed mailboxes or folders to search: from:"alex" subject:"follow™

5)

Mailbox Database.edb

C:\Exchange Server Database\Mailbox Database.edb
Size: 904 Mb

Date: 3/13/2014

Version: Exchange Server 2013

Transaction logs not used.

22 maiboxes. Select a mailbox to display folders.
Load time: 00:00:04

Display time: Local

PST encoding: Unicode (Microsoft Outlook 2003, 2007, 2010 and 2013)
Show deleted items: Only non-deleted items

Incomplete messages: Hide

Search within attachments: On

File info r

Completed

Operators are listed below:

Operator Definition Example

from: Used to specify the sender. Example: from:alex

Meaning: messages from Alex.

to: Used to specify a recipient. Example: to:John

John (by any user).

Meaning: all messages that were sent to

line.

subject: Search for words in the subject Example: subject:dinner

"dinner" in the subject.

Meaning: messages that have the word
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Operator

OR

AND or Space

(hyphen)

has:attachment

att_name:

cc: bec:

(quotes)

Definition

Search for messages matching
term A or term B. OR must be in
all caps

Search for messages matching
term A and term B.

AND must be in all caps.

Used to exclude messages from
your search.

Search for messages with an
attachment.

Search for messages with
specified attachment name.

Used to specify recipients in the
cc: or bec: fields

Search on bcc: cannot retrieve
messages on which you were blind
carbon copied.

Used to search for an exact
phrase*

*capitalization isn't taken into
consideration.

Example

Example: from:alex OR from:john
Meaning: messages from Alex or from
John.

Example: from:alex AND from:john
Meaning: messages from Alex and from
John.

Example: dinner -movie

Meaning: messages that contain the
word "dinner" but do not contain the
word "movie".

Example: from:john has:attachment
Meaning: messages from John that have
an attachment.

Example: to:jane att_name:photo.png
Meaning: messages to Jane that have an
attachment with specified attachment
name.

Example: cc:John

Meaning: messages that were cc-ed to
John.

Example: "i'm feeling lucky"

Meaning: messages containing the
phrase "i'm feeling lucky" or "I'm feeling
lucky".

Example: subject:"dinner and a movie"
Meaning: messages containing the
phrase "dinner and a movie" in the
subject.
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Operator

()

create_time:[yyyymmdd
yyyymmdd]

after: before:

older: newer:

older_than: newer_than:

size:

Definition
Used to group words Used to

specify terms that shouldn't be
excluded.

Search for messages created
during a certain period of time.

Search for messages sent or

received during a certain period of

time

(using the date format
yyyymmdd).

Similar to older and newer, but
allows relative dates using d, m,
and y for day, month, and year.

Search for messages larger than
the specified size in bytes.

Abbreviations for numbers (B, K,
M) are allowed. Size limit is
2000MB.

Example

Example: from:alex (dinner OR movie)
Meaning: messages from Alex that
contain either the word "dinner" or the
word "movie".

Example: subject:(dinner movie)

Meaning: messages in which the subject
contains both the word "dinner" and the
word "movie".

Example: create_time:[20110416
20110516]

Meaning: messages created between
April 16, 2011 and May 16, 2011.

Example: after:20110416
before:20110516

Meaning: messages sent between April
16,2011 and May 16, 2011.

More precisely: messages sent after
12:00 AM (or 00:00) April 16, 2011 and
before May 16, 2011.

Example: newer_than:2d

Meaning: finds messages sent within the
last two days.

Example: size:300

Meaning: messages larger than 300
bytes

Example: size:[300 2000]

Meaning: messages larger than 300
bytes but smaller than 2000 bytes.
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Operator Definition Example

larger: smaller: Similar to size, allows Example: larger:1M

abbreviations for numbers (B, K, Meaning: All messages of at least 1MB in

M). Size limit is .
size.
2000MB. Example: larger:150K smaller:1M
Meaning: messages larger than 150KB
but smaller than 1MB.
+ Match the search term exactly. Example: +movie
(plus sign) Meaning: minds messages containing

“movie” but not “movies” or “movei”.

Using wildcard characters

A wildcard character is a keyboard character such as an asterisk (*) or a question mark (?) that is used to
represent one or more characters when you are searching for files, folders, printers, computers, or people.
Wildcard characters are often used in place of one or more characters when you do not know what the real
character is or you do not want to type the entire name.

Wildcard character Definition Example

* Used to substitute for zero Example: subject:d*g

(asterisk) or more characters. Meaning: finds messages
containing words "doing", "dog",
"debug", etc.

? Used to substitute for a Example: subject:d?g

single character in a name.

(question mark) Meaning: finds messages

containing words "dog", "dig",
"dug", etc.

Note
Use checked 'Find whole word only' in case using question mark ("?") in the start of the word.
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Note
Other special characters are not used for search. Search query, containing special characters, may return
incorrect results.

Search within attachments

Search within attachments is enabled by default. This option can be changed in the Options menu.

This o

File

<

£
£
£
£
£
3
£
£
£
£
£
£
£
3
£
£
£
£
3
£
£
£

Options | Help

Show notification panel
‘ Show progress dialog

earch within ati

PST encoding
Incomplete messages
Show deleted items

vy v v v

Display time
= oo
7-[_] =9 HealthMailboxadeJae Fe5b54860a1cf0218267
-[_] 9 HealthMailboxbaa8042¢260149aa328ba554e(
i-[_]£9 John

i-[_] =9 Juliet Capulet

i[9 Kyle Pakemman

7[5 Luise

-[_] =9 Maria Woods

-[_] 9 Michael

i-[_] =9 Personal Archive - HealthMailboxadeSae Fe5b!
-[_] =9 Personal Archive - HealthMailboxbaa8042e260
7] Richard

-[_] 9 Rober Rise

-[_] 9 Romeo Montague

-2 Rudy Raid

-[_] &9 Susane Tyler |
7-[]=9 SystemMailbox{adeSae #-505-4860-a1cf-021¢
-] 29 Tim Goodler

Completed

ption allows to perform search in attachments content.

Select mailboxes or folders to search

Mailbox Database.edb

C:\Exchange Server Database\Maibox Database.edb
Size: 904 Mb

Date: 3/13/2014

Version: Exchange Server 2013

Transaction logs not used.

22 maiboxes. Select a maibox to display folders.
Load time: 00:00:04

Display time: Local

PST encoding: Unicode (Microsoft Outiook 2003, 2007, 2010 and 2013)
Show deleted items: Only non-deleted items

Incomplete messages: Hide

Search within attachments: On

[ File info |

Note
After enabling this option the database will have to be reopened. Search process may take longer when
search within attachments is enabled.

5.10 Exporting items

Granular Restore for Microsoft Exchange and SQL includes the injection capability for items (emails, calendars,

contacts, etc.) from offline database and PST/OST files to original live Exchange databases as well as granular
data extraction to Personal Storage File (.pst) files.
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5.11 Restore to original live Exchange Server. Standard mode

Important Note

Standard export mode requires access to Active Directory to establish connection to Exchange Server.
The program requests users list from Active Directory and checks if IDs of offline and live user mailboxes
match. That's why the user, logged in, must be a domain user.

After startup, opening an EDB file and checking items the main window of the application looks as follows:

File Options Help

‘ Browse
=-[m] 43 Mailbox Database.edb
=-[w] =5 Alex Clark
-[_]24] Calendar (438)
-.[_] =] Contacts (45)
.[]C3 Deleted tems (25)
-] Drafts (0)
Hc
-] 8 Joumal (27)
--[JZ@ Junk Email (0)
-] Notes (40)
[ Outbox (0)
[ Sent tems (0)
[ Tasks (48)
-] 9 Andrew Wait
i-[]59 Andy Kot
-] Brian
-] Dalia

>

A 0000000ROO0000 =

=

FEEEEEEEREEEE §

0
!
0
g
g
0
!
0
0
0
0

Subject
Do you persuade yourseff t...

| regret that | am unable torr...
Alas, the heavy basketwhic...
He went up a dark and narr...

Noone, even there, could i...
One of the things particular...
Stephen Brice read the ne....

Give me some light! Give m...
His condition leaves him no...
What a pied ninny’s this!
Your vows, your memories, ...
The riders could be heard ...
The sinewand heart of man...

| Search in Alex Clark

From

Andy Kort

Brian

Alex Clark

Rudy Raid
Romeo Montague
Robert Rise
Luise

Michael

Juliet Capulet

.. Maria Woods

John
Andrew Wait
Susane Tyler

To

Susane Tyler; Andy Kort; Juliet Capulet..
John; Brian; Tim Goodler; Kyle Pakem...
Dalia; Kyle Pakerman; Michael; Susan...
Brian; Michae!; Richard; Dalia; Luise; T...
Brian; Alex Clark; Richard; Romeo Mon...
John; Maria Woods; Richard: Alex Clar...
Alex Clark; John; Tim Goodler; Michael...
Romeo Montague: Richard; Andrew W...
Romeo Montague: Richard; Juliet Cap...
Maria Woods; Brian; Juliet Capulet; Ro...
Robert Rise; Maria Woods: Andrew W...
Susane Tyler; Maria Woods; Romeo M...
Brian; Juliet Capulet; Andy Kort; Robert...

Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12,2 v

is my lady mother. Itis my lady mother.

[ ]9 HealthMailboxadeSae Fe5054860a1cf0218
-9 HealthMailboxbaa8042e2601492a928ba55
i-[ ]9 John

+-[_] 9 Juliet Capulet

£

[c

c

c

£

£

f From: Juliet Capulet
E]‘ (159 Kyle Pakeman Sent Wednesday, March 12, 2014 10:28:00 AM UTC-07:00
£

c

[«

£

£

£

£

i é Luise To: "Romeo Montague” <Romeo.Montague@no-such-email.com>, "Richard” <Richard@no-such-email.com...
-] =9 Maria Woods

-] 9 Michael

-] 9 Personal Archive - HealthMailboxadeSae e

igg :‘e;::l Archive - HealthMaibaxbaa8l42e: The day is broke; be wary, look about.

3 Jul. Then, window, let day in, and let life out.
+-[]9 Robert Rise N - realy
< Preview | Properties ‘

Nurse. Madam!
Jul. Nurse?
Nurse. Your lady mother is coming to your chamber.

Completed Selected: 1 item(s) in 1 mailbox(es)

Clicking the injection button will bring up the following dialog:
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Host (ex.: contoso.com or 192.168.0.5): About export into original mailbox

} ES2013.no-such-email.com v | | Refresh ’ ’ Advanced... Selected items will be copied from
offline mailboxes into their original
Details: locations on live Exchange Server.
Export from source mailbox ‘Alex Clark’ to destination mailbox Alex.Clark @no-such-email.com: 6 items |

The destination Exchange Server is
detected automatically using the
current Active Directory domain.
Current user should be a member
of the same domain as target
Exchange Server and should have

Exchange impersonation access to
destination mailboxes.

Each selected item will go to its
original location in respective
mailbox, e.g. Patrick’s offline mail
will goto Patrick's mailbox, Lisa's
calendar items to Lisa’s mailbox
etc. When selected items cannot be
matched to destination mailbox,
they will not be exported.

[T] Unselect successfully exported items

Diagnostics

Domain name of the machine with Exchange Server will be automatically detected if current machine is in the
same domain with Exchange Server. Otherwise, the host will not be detected and has to be entered manually.
By default, Granular Restore for Microsoft Exchange and SQL uses current user to establish the connection. If
current user doesn't have rights to impersonate selected for export user, an appropriate error will appear in
details.

In case of error it is recommended to use the Advanced button and configure the connection settings.

Host {ex.: contoso.com or 192.168.0.5):
[

credenti Exchange impersonation lets you connect to
AL - 2 mailbox other than the default one for your
credentials. To use the feature, access
User logon name {ex.: user1): permissions need to be configured at
Exchange Server.

Password:
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There are two ways to connect to selected mailbox:
1. Use credentials of selected mailbox.
2. Specify the user that has impersonation rights.

To use credential of selected mailbox, enter host name of machine with Client Access Role, unmark Use current
Windows credentials enter user name and password and press Connect.

Host {ex.: contoso.com or 192.168.0.5):
l ES2013.no-such-email.com

et et Exchange impersonation lets you connect to
L] Use s = a mailbox other than the default one for your
credentials. To use the feature, access
User logon name (ex.: user1): permissions need to be configured at

‘AIex.Clark Exchange Server.

Password:

["] Save password

To use Exchange impersonation to establish the connection, enter host name of machine with Client Access
role, unmark Use current Windows credentials, enter credentials of the user with impersonation rights and
press Connect. In the example below Brian has impersonation rights to access Dalia's mailbox.

Host {ex.: contoso.com or 192.168.0.5):
|ES2013.n0-such-email.com

: Exchange impersonation lets you connect to
[] Use cusrort Windows credentals 2 mailbox other than the default one for your
credentials. To use the feature, access
User logon name (ex.: user1): permissions need to be configured at

IBn'an Exchange Server.

Password:

Im.

["] Save password

Exporting to live Exchange is also available via the File menu.
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s X

File | Options  Help
Open file... Ctrl+0
Recent 5 Feamn in Alex Clark p
Close file
Reload database using transaction logs oo o i e e
i at
Search for files to open... e 3 |
= She was giad that Jo shoul.. Luise Maria Woods; Kyle Pakeman; Luise; .. Wednesday, March 12,2 |
Export selected items into PST... Ctrl+S 2§ Insnatwe, tisabirayan... Kjle Pokeman  Ancrew Wat; Richard; John; Dalia; Ro... Wednesday, March 12, 2
T —— = tis my lady mother. kismy... Juiiet Capulet Romeo Montague; Richard; Dalia; Mic... Wednesday, March 12,2
] - e = Butthat it might not appeart... John Romeo Montague: Andy Kort: Robert ... Wednesday, March 12,2
AT T P A% = { Doyoupersuade yourseft... Andy Kort Susane Tyler: Andy Kort; ulet Capuiet... Wednesday, March 12,2
Open log folder = I regretthat | am unable tor... Bian John; Brian; Tim Goodeer: Kyle Pakem... Wednesday, March 12,2
Delets % fil dl = g Alas, the heavy basketwhic... Alex Clark Dalia; Kyle Pakeman; Michael; Susan... Wednesday, March 12,2
e 2 ) Hewentupadark andnar.. RudyRaid Brian; Michael: Richard; Daiis; Luise; T.. Wednesday, March 12,2
Bit Alt+X = Noone, even there, could ... Romeo Mortague  Brian; Alex Clark; Richard; Romeo Mon... Wednesday, March 12, 2
T rTeT = ﬂ One of the things particularl... Robert Rise John; Maria Woods: Richard; Alex Clar... Wednesday, March 12, 2
[ Tasks (42) 4 ] StephenBicersadthene... Luise Aex Clark; John; Tim Goodeer; Michael... Wednesday, March 12, 2
(159 Andrew Wit = (| Gvemesomelight!Givem... Michael Romeo Montague; Richard; Andrew W... Wednesday, March 12,2
L1 Aoy Kent = ] Hiscondtionleaves himno... Juliet Capulet Romeo Mortague; Richard: Juliet Cap... Wednesday, March 12, 2
-9 Bian = What a pied ninny'sthis! ... Maria Woods Maria Woods; Bran; Julet Capulet; Ro... Wednesday, March 12, 2
-89 Daia 9 Yourvows, your memories, .. John Robet Rise; Maria Woods: Andrew W... Wednesday, Merch 12.2
- Sg Mx:::x;’:;ﬂ;g:; (| Therders coudbeheardl.. Andrew Wat Susane Tyler; Maria Woods; Romeo M... Wednesday, March 12,2
Dg John = ﬂ The sinewand heart of man... Susane Tyler Brian; Juliet Capulet; Andy Kort; Robert... Wednesday, March 12,2
T155 et Capult = Now, herald, are the dead ... Alex Clark Michael; Alex Clark; Susane Tyler; Ro... Wednesday, March 12, 2
£ e Pakeman = Dieu vous garde, monsieur.... Michae! Maria Woods; Robett Rise Wednesday, March 12,2
|:|§ ise; = [ you had seen the look in ... Romeo Montague  Dalia; Juliet Capulet; Alex Clark; Rome... Wednesday, March 12, 2
[]23 Maria Woods | = She wore a gray blouse wi... Robert Rise Alex Clark; Susane Tyler; Maria Woods... Wednesday, March 12. 2
(]9 Michael | = Butthough the pubiic scho... Luise John; Brian; Michael; Andy Kot Maria ... Wednesday, March 12, 2
[[]£9 Personal Archive - HeatthMaiboxadeSae e | = ifitwas in gold: but at the sa... Andrew Wait Rudy Raid; Juliet Capulet; Brian; Andy ... Wednesday, March 12,2
[ Personal Archive - HealthMaiboxbaa8042e. | = My stars shine darkly over .. Rudy Raid Juliet Capulet; Tim Goodler; Alex Clark;... Wednesday, March 12, 2
|:|§ Richard | = ﬂ Charley was of these peopl... Romeo Montague  Susane Tyler; Alex Clark; Michael; Rud... Wednesday, March 12. 2
[1£3 Robert Rise vl = Richard Richard; John; Andy Kort; Robert Rise:... Wednesday, March 12,2 ¥
< > < o)
Completed Selected: 1 folder(s) in 1 mailbox(es) i |

Access role, unmark Use current Windows credentials, enter credentials of the user with impersonation

for export. You will be shown a progress window during the export. The window shows the number of saved
folders, messages, errors and total expected items to be restored. You can disable the progress window
directly in the window or go to the Options menu and select Show progress dialog.

The export can be cancelled by clicking the Cancel exporting button on the taskbar.

File  Options

-
Browse

| =-[®]{} Meailbox Database edb Type
[V 59 Alex Clark =
14 Calendar (438)
A Contacts (45)

Help

% ‘ Search in Alex Clark

{ Subject From To
She was glad that Jo shoul... Luise Maria Woods; Kyle Pakerman; Luise; ...
=] Q In itsnature, it is arbitrary an... Kyle Pakerman Andrew Wait; Richard; John; Dalia; Ro...

Wednesday, March 12, 2 ‘
Wednesday, March 12, 2

3 Deleted ttems (25)
(3 Drafts (0)

] o (1046 |
Al Joumal (27)

3 Junk Email (0)

Notes{4t) Folders

Errors
[]D@ Andrew Wait
-] &9 Andy Kott
-] &9 Bran

&[] &9 Dalia
[]E]é HealthMailboxadeJae Ae5b54860a1cf021¢
#-[]£9 HealthMailboxbaaB042e26014%aa928ba5%
[]-.-[:]§ John
[]---[:]g Juliet Capulet
[ ]9 Kyle Pakerman

@[5 Luise

(-] &9 Maria Woods

-] Michael

(#-[_]£9 Personal Archive - HealthMailboxadeSae e
#-[_]£9 Personal Archive - HealthMailboxbaa8042e:
[][]@ Richard

(-] Robert Rise

< >

KRR

DEEEEEEEE

<

~RIEE

Progress

0

Messages 16

0

Total messages count

Elapsed time

Cancel cument operatiol
Show the dialog next time

Now, herald, are the dead ...

Dieu vous garde, monsier....
If you had seen the look in ...

She wore a gray blouse wit...
But though the public scho...

if itwas in gold; but at the sa...

My stars shine darkly over ...
g Charley was of these peopl...

Exporting into original Exchange Server mailbox

Close

Alex Clark
Michael

Romeo Montague
Robert Rise

Luise

Andrew Wait
Rudy Raid
Romeo Montague
Richard

* ttague; Richard; Dalia; Mic...
itague; Andy Kort; Robert ...
or; Andy Kort; Juliet Capulet...

Tim Goodler; Kyle Pakem...

?akeman; Michael; Susan...

sel; Richard; Dalia; Luise: T...
Zlark; Richard; Romeo Mon...
Woods:; Richard; Alex Clar...
lohn; Tim Goodler; Michael...
itague; Richard; Andrew W...
itague; Richard: Juliet Cap...

Is; Brian; Juliet Capulet; Ro...
: Maria Woods; Andrew W...
»r; Maria Woods; Romeo M...
Capulet; Andy Kort; Robert...

Michael; Alex Clark; Susane Tyler; Ro...

Maria Woods: Robert Rise

Dalia; Juliet Capulet; Alex Clark; Rome...

Alex Clark; Susane Tyler; Maria Woods...

John; Brian; Michael; Andy Kort; Maria ...

Rudy Raid:; Juliet Capulet; Brian; Andy ...

Juliet Capulet; Tim Goodler; Alex Clark:...

Susane Tyler; Alex Clark; Michael; Rud...

Richard; John: Andy Kort; Robert Rise:...

Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2

Wednesday, March 12,2 ¥
>

Exporting into original Exchange Server mailbox (folders: 0...

00:00:05

Selected: 1 mailbox(es)
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5.12 Working with clustered Exchange Server configuration

Exporting data into live instance of clustered Exchange Server does not differ from working with any other
server configuration. Even if there are several servers with Mailbox Server roles in your configuration, and they
have been added to your CCR/DAG, data can be easily restored.

Client Access
Server

Active Directory
Domain Controller

CCR/DAG

Mailbox Mailbox Mailbox
L_Serverl Server2 Server 3

v
- Client PC with
Restore Tool
|
P LAEEERT N
P4

>
V E

Offline Database
Storage

As you can see on the scheme, to export data into live server, Granular Restore for Microsoft Exchange and
SQL calls Client Access Server to get access to specified mailbox. And it doesn't really matter which of existing
Mailbox Servers stores target mailbox - data will be exported to the right place.

The IP-address or FQDN of Client Access Server should be specified in the Host field while using the Expert
mode. In the Export into original mode FQDN of this server is detected automatically by calling Active Directory
domain controller.

5.13 Restore to PST files

To save items marked for export, click the Export selected items button on the toolbar or select the point in
the File menu.
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File

<

Options  Help

.

| Search in Alex Clark

I

EJEl +# Mailbox Database.edb

=-[m] 59 Alex Clark
[]i21 Calendar (432)
[] 8] Contacts (45)

C (0)
G Inbox (1.046) |
[J &8 Joumal (27)
[ Junk Email (0)
[Jw. Notes (40)
[ Outbox (0)
[Cca Sent tems (0)
[J¥ Tasks (48)
- ]9 Andrew Wait
-[]59 Andy Kort
@[] Brian
-] Dalia
(-] 59 HeatthMailboxade9ae e 5b54860a1cf0218
-[ ]9 HealthMailboxbaa8042¢260149aa928ba55
-] John
-] 59 Juliet Capulet
£
£
£
3
£
£
3
£

i-[ ]9 Kyle Pakerman

s (1 use

-] 9 Maria Woods

7-[_] =9 Michael

7-[_] =9 Personal Archive - HealthMailboxade9ae e
-[_] 9 Personal Archive - HealthMailboxbaa8042e:
-] Richard

-] Robert Rise

NEHEE

KRR RE R

Iy

AR EEE
IEEEEEEEREEEE

g
0

Li=Ti=Tim} oo [ —=T.~1 [<—1

Subject

She was glad that Jo shoul....

In itsnature, it is arbitrary an...
It is my lady mother. It is my...
Butthat it might not appeart...
Do you persuade yourseff t...

| regret that | am unable torr...
Alas, the heavy basketwhic...
He went up a dark and nar...
Noone, even there, could |i...
One of the things particular...
Stephen Brice read the ne...

Give me some light! Give m...
His condition leaves him no...
.. Maria Woods

What a pied ninny'’s this!

Your vows, your memories, ...
The riders could be heard ...
The sinewand heart of man...
Now, herald, are the dead ...
Dieu vous garde, monsier....
If you had seen the look in ..
She wore a gray blouse wit...
But though the public scho...
if itwas in gold; but at the sa...
My stars shine darkly over ...
Charley was of these peopl...

From

Luise

Kyle Pakerman
Juliet Capulet
John
Andy Kort
Brian

Alex Clark
Rudy Raid
Romeo Montague
Robert Rise
Luise

Michael

Juliet Capulet

John

Andrew Wait
Susane Tyler
Alex Clark
Michael

Romeo Montague
Robert Rise

Luise

Andrew Wait
Rudy Raid
Romeo Montague
Richard

To

Maria Woods; Kyle Pakerman; Luise; ...

Andrew Wait; Richard; John; Dalia; Ro...
Romeo Montague:; Richard: Dalia; Mic...
Romeo Montague: Andy Kort; Robert ...

Susane Tyler; Andy Kort; Juliet Capulet...
John; Brian; Tim Goodler; Kyle Pakem...
Dalia; Kyle Pakerman; Michael; Susan...
Brian; Michael; Richard; Dalia; Luise; T...
Brian; Alex Clark; Richard; Romeo Mon...
John; Maria Woods; Richard; Alex Clar...
Alex Clark: John; Tim Goodler; Michael...

Romeo Montague; Richard: Andrew W...

Romeo Montague: Richard: Juliet Cap...
Maria Woods; Brian; Juliet Capulet; Ro...
Robert Rise: Maria Woods; Andrew W...
Susane Tyler; Maria Woods; Romeo M...
Brian; Juliet Capulet; Andy Kort; Robert...
Michael; Alex Clark; Susane Tyler; Ro...

Maria Woods; Robert Rise

Dalia; Juliet Capulet; Alex Clark; Rome...

Alex Clark; Susane Tyler; Maria Woods...

John; Brian; Michael; Andy Kort; Maria ...
Rudy Raid; Juliet Capulet; Brian; Andy ...
Juliet Capulet; Tim Goodler; Alex Clark:...

Susane Tyler; Alex Clark; Michael; Rud...

Richard; John: Andy Kort; Robert Rise:...

Created

Wednesday, March 12, 2 ‘

Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2
Wednesday, March 12, 2

>

Al

v

Completed

Selected: 1 folder(s) in 1 mailbox(es)

You will be asked to select or create the destination folder for recovered data:

Selected data will be saved into pst file(s). To start the export select the destination

folder or create a new one and click OK. The export process will start immediately.

4 | Recovered
.. CLIENT-PC
. Recovered_sessionl
. Recovered_session2
. Recovered_session3
. Recovered_session4

.. Recovered_session5

| » Recovered_sessionSl
> TestRenarts

~

v

PST encoding: [ Unicode (Microsoft Outlook 2003, 2007, 2010 and 2013)

v

| Make New Folder |

o

Cancel

I»:

After selecting folder, the export will start. Required time depends on how many items are selected for export.

You will be shown a progress window during the export. The window shows the number of saved mailboxes,

folders, messages and total expected items to be restored (1). You can disable the progress window directly in
the window or go to the Options menu and select Show progress dialog.
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The export can be cancelled by clicking an appropriate link in the progress dialog window (2) or by clicking the

Cancel export button on the taskbar (3).

File Options Help
; ld ! y Search in all mailboxes pel
Browse ©
=2
(-[V] =9 Alex Clark Mailbox Database.edb
(#-[V] 59 Andrew Wait
o) é Andy Kort PR S S NI S ¥ P SR S S TS
(#-[V] &9 Brian Progress
(#-[¥] 9 Dalia
#-[¥] &9 HealthMailboxadeJae e5b54860a1cf021¢
[#-[¥] &9 HealthMailboxbaa8042e26014%aa928ba5% Exporting into PST... 27%
[-[V] 59 John g)
(#-[V] 55 Juliet Capulet Mailboxes 9
) ’:; Kyle Pakeman Folders 100
& Luise Messages
& g Maria Woods Total
& =5 Michael Total messages count
[} —J Personal Archive - HealthMailboxadeSae 7
(#1-[¥] 5 Personal Archive - HealthMailboxbaa8042e ~ Elapsed time 00:01:05 d 2013)
(#-[v] =) Richard
Gl e  —
@ ~J Romeo Montague ¥
@ =y Rudy Raid , .
& 15 S i Catominnn ) © |
(-] SystemMailbox{adeSae F-e5b5-4860-a1cf- Show the dialog next time Close ‘
(#-[¥]£9 Tim Goodler —————

<
Exporting into PST... 27%

00:01:05 Selected: 22 mailbox(es)

Tip

If you closed the progress window, it can be shown again by clicking on the progress bar on the status.

PST file naming, size and format

Granular Restore for Microsoft Exchange and SQL exports each mail store into a separate .pst file named
“Recovery NNN - <Mailbox Name>[ - VVV] . pst”, where NNN is current recovery session identifier, VVV —
volume number in case the PST has to be written in more than one volume.

Example:

Recovery 001 - John Doe.pst
Recovery 001 - John Doe - 001.pst
Recovery 001 - John Doe - 002.pst

Recovery 001 - Mary Smith.pst

With large exports, there can be more than one file on the output. Additional files are created automatically
when the file size limit is hit. The size volume limit depends on the output file encoding. For ANSI PST files the
limit is 1GB, for Unicode files it is 19GB.

Opening exported items in Outlook
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To view and manipulate exported items, use Microsoft Outlook to open the Personal Storage File (.pst) files
exported by Granular Restore for Microsoft Exchange and SQL:

1. Start Outlook.
2. Click File and choose Open Outlook Data File.

3. Select exported pst file and click OK.

0|l - ; Outlook Today - Microsoft Outlook
File. | Home Send / Receive Folder View
£ Open Calendar
P Open a calendar file in Outlook (.ics
o
Info H
Open § {3 Open Outlook Data File
Open an Outlook data file (.pst).
Print
Help g\i 0| Open Outlook Data File
] Opti g @Qv <| » Libraries » Documents » |4,‘ l Search Documents Lol
:] Options @ =5 - Search Documents
Exit Organize v New folder = bl @
= Recent PI A :
e Documents library e .
Arrange by: Folder ¥
Includes: 2 locations
4 Libraries =
=) Documents Name Date modified g 5=
& Music 9] Recovery 001 - Juliet Capulet 8/24/20122:22PM  (
= Pictures £ 2] Recovery 002 - Andrew Wait C
E Videos 9] Recovery 002 - Susane Tyler C
5] Recovery 002 - Kyle Pakerman C
18 Computer 9] Recovery 002 - Andy Kort C
L Local Disk (C:) 9] Recovery 002 - SystemMailbox{78d3a78c-3€71-42¢9-a8... C
s Local Disk (D:) 9] Recovery 002 - Rudy Raid C
ca Local Disk (E) + « )0 cncnns 002 _Llict Sazia ,’A
File name: Recovery 001 - Juliet Capulet v [Outlook Data File V]
Toos v [ ok | [ Cancel |
Note

It is not recommended to move .pst files that are open in Outlook. Before moving, right-click the name
of the Outlook Data File (.pst) and click Close.

Restoring exported items into Exchange Server

Items extracted from a mail store can be easily restored into a live server:

Make sure you have Microsoft Outlook with access to the mailbox you want to restore items into.
Open .pst file with exported messages.

Open the mailbox you need to import data into.

P wonNoe

Select the items and drag-and-drop them back into the original folders. They will be automatically
synchronized with the live Exchange Server database.
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B vome | sena/Receve  Foler  view
. = = 2R &Y . >
@ | %= Clean Up x = _\l E_a BR, Meeting |% Restored Mail () To Manager - IE l
& Junk ~ ¢ 34 Team E-mail / Done >
New  New Delete = Reply Reply Forward % More = ~ - = —1| Move Oi
Elnail Reims+ All {4 Reply & Delete 7z Create New (7] %
New Delete Respond Quick Steps = Mov
Drag Your Favorite Folders Here <
|Search Inbox (Ctri~E) P
4 Exchange Mailbox Arrange By: Date Newestontop ¥ |«
L} In N -
[=) sent Items it

(3] Deleted Items
[ Drafts

L@ Junk E-mail
3] Outbox [2]

[l Restored Mail
[F) RSS Feeds

& Search Folders
[l Shortcuts

4 Recovery 001 - Juliet Capulet
(3] Deleted Items

[ Conversation Action Settings
[l Drafts

[ Junk E-Mail
[0 search Folders
[ Orphaned Folders
[ Outbox

subj About the Test Mailbox Store
-1 Romeo Montague

The farmer imagines power and
-] John

Whilst the waorld is thus

-] Robert Rise
POLARITY or action and reaction we meet in

{4 Alex Clark
F LIMITED RIGHT OF REPLACEMENT

Emerson spent the latter part of his life in lecturing and

Thu 8/16

$
Thu 8/16
4

Thu 8/16
3+
Thu 8/16
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6 Command-line interface

The command line feature allows you to easily process several databases.

Usage: esr.exe <source> <destination>

Example: esr.exe "c:\Mailbox Database.edb" "c:\results\"

Below is a list of commands with their description that can be used in command line:

There are several ways to set the source file(s):
Operation Description
<file mask path> mask to path with files

sets a path to file which contains a
/list=<path> list with files to recover

sets enumeration of files to
Jlist={filel, file2, ..., fileN} recover.

Full path to file must be used

Specify the destination directory for the recovered file(s):
Operation Description

<out dir> path to output directory

Detailing parameters:
Operation Description

sets the initial directory for the
/initdir=<path>
Open database dialog

. shows messages that have been
-notfilterfaultymessages . .
filtered due to their damage

redirects console output to text

/redirect=<path> _
file

if set - the product will remove all
/cleartemp
temp data on startup

Example
esr.exe c:\*.edb c :\results\

esr.exe
/list=d:\files_to_recover.txt
c:\results\

esr.exe /list={d:\1.edb, d:\2.edb}
c:\results\

Example

esr.exe c:\*.edb c :\results\

Example

esr.exe /initdir="c:\EDB
Mailboxes\"

esr.exe -notfilterfaultymessages

esr.exe c:\*.edb c :\results\
/redirect="c:\result.txt"

esr.exe /cleartemp
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6.1 Extended command-line interface

Extended command-line interface can help to automate various command-line operation.

Automation commands begin with /auto switch. To address individual items, such as mailboxes, folders and

messages, their IDs are used. To obtain an object’s ID, the 'lh' automation command is used.

Operation

/auto

fd

Description

Begins automation sequence.
Parameters that follow will
specify automation.

Lists EDB objects (tab-separated:

Id, Name, Parent Id). Also see
/items and /r options.

Note: mailbox(es) or folder(s) IDs

must be used in /items
parameter.

Lists messages (tab-separated:
Id, Subject).

Also see /items and /r options.

Note: folder(s) ids must be used
in /items parameter

Shows folder details (tab-
separated: Id, Name,
MessageCount, Class). Also see
/items option.

Note: folder(s) ids must be used
in /items parameter

Extracts items. Also see /items
and /rcs options.

See /pstencoding to set PST
encoding.

See /outdir to set output folder.

Example

esr.exe "c:\EDB
Mailboxes\privl.edb" /auto Ih
/items={FF55DD44-EE6788DD,
BB3345F4-EE788922}

esr.exe "c:\EDB
Mailboxes\privl.edb" /auto |h

/items={FF55DD44-EE6788DD,
BB3345F4-EE788922)

esr.exe "c:\EDB
Mailboxes\privl.edb" /auto Im
/items={FF55DD44-EE6788DD,
BB3345F4-EE788922}

esr.exe "c:\EDB
Mailboxes\privl.edb" /auto fd

/items={FF55DD44-EE6788DD}

esr.exe "c:\EDB
Mailboxes\privl.edb" /auto e
/items={FF55DD44-EE6788DD}
Joutdir="C:\results\”
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Operation

ea

pm

Description

Note: mailbox(es), folder(s) or
email(s) IDs must be used in
/items parameter.

Extracts attachments from

message. Also see / items option.

See /outdir to set output folder.

Note: folder(s) or email(s) ids
must be used in / items
parameter

Does performance test (tab-
separated output:

Operation Elapsed time
hh:mm:ss, Count).

Sequence:
Opens EDB

). Saves items.

Use /itemscount to pass a
number of items to save

Use /items to pass a folder with
items to save or an item list(or
one item) to save.

See /pstencoding to set PST
encoding.

See /outdir to set output folder.

Note: if you pass an email id in
/items parameter it will be saved
“/itemscount” times.

Example

esr.exe "c:\EDB
Mailboxes\privl.edb" /auto ea
/items={FF55DD44-EE6788DD}
Joutdir="C:\results\”

esr.exe "c:\EDB
Mailboxes\privl.edb" /auto pm
/items={FF55DD44-EE6788DD}
/itemscount=3000
Joutdir="C:\results\”
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Operation

Description

Searches for provided query
string (see /query option).

Output: same as in Im command.

Use /items option to set a folder
where to search. Otherwise,

Example

esr.exe "c:\EDB
Mailboxes\privl.edb" /auto s
/query={has_words=email}

search will be performed on a

whole database.

Below there is list of options and their descriptions that can be used with command-line operations, described

above.

Operation

/items={id1,id2,...}

/r

/itemscount=<count>

/query=<query>

Description

List of items(mailbox, folder,
message, calendar IDs etc.) in
hexadecimal format Root ID =1
(/items={1})

Recursively includes subfolders
into current operation.

Count of items to save.

Search query string.

u,

;|” sequence is used to divide
search parameters in string.

Parameters (see search tab of the
ul):
has_words — “Has words” field

no_words — “Doesn’t have”
field

has_attach — “Has attachments”
field. True or false.

Example

esr.exe "c:\EDB Mailboxes\privl.edb"
/auto lh /items={FF55DD44-EE6788DD,
BB3345F4-EE788922}

esr.exe "c:\EDB Mailboxes\privl.edb"
/auto Im /items={FF55DD44-EE6788DD,
BB3345F4-EE788922} /r

esr.exe "c:\EDB Mailboxes\privl.edb"
/auto ps /items={FF55DD44-EE6788DD}
/itemscount=5

esr.exe "c:\EDB Mailboxes\privl.edb"
/auto s /query={has_words=email; |
no_words=theme;| has_attach=true;|
from=Brian; |to=Romeo; | subject=Test
this App; | datefrom=10/04/2013;|
dateto=10/05/2013}
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Operation Description Example

. from - “From” field
. to—“To” field
5. subject — “Subject” field

’. datefrom — start date of range
in “dd/MM/ yyyy” format

3. dateto—end date of range in
“dd/MM/ yyyy” format

/pstencoding=<encoding> | Encoding of PST file. esr.exe "c:\EDB Mailboxes\privl.edb"
Values: /auto ps /items={FF55DD44-EE6788DD}
/itemscount=3000 /pstencoding=ANSI
Unicode(default), ANSI. Joutdir="C:\results\”
/outdir=<path> Path to output folder esr.exe "c:\EDB Mailboxes\privl.edb"

/auto ps /items={FF55DD44-EE6788DD}
/itemscount=3000 /outdir="C:\results\”

Application Exit Codes

Code Description

0 OK

1 Some errors
in
parameters

2 No data to
restore

3 Empty
/itemor/
outdir
parameter,
operation
did not start
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7 Glossary

This glossary lists terms and their synonyms, most commonly used in Granular Restore for Microsoft Exchange
and SQL help.

AD - Active Directory (AD) is a directory service implemented by Microsoft for Windows domain networks. An
AD domain controller authenticates and authorizes all users and computers in a Windows domain type
network. For additional information, please visit http://en.wikipedia.org/wiki/Active_Directory.

ANSI PST format - An old PST-file format, used in Outlook 97-2002. ANSI format has a 2 GB limit in file size.
Deleted items - Items/folders deleted from a mailbox hierarchy.
Destination folder/mailbox - A folder/mailbox, selected for export.

EDB - An Exchange database format, used to store information from users’ mailboxes. Synonyms: Exchange
Server database, dataset.

EWS - Exchange Web Services. EWS provides the functionality to enable client applications to communicate
with the Exchange server. EWS provides access to much of the same data that is made available through
Microsoft Office Outlook.

Exchange impersonation - Exchange impersonation enables a caller to impersonate a given account so that the
operations can be performed with the rights of the impersonated account, instead of the rights that are
associated with the caller's account. Configuration information is available at http://msdn.microsoft.com/en-
us/ library/office/bb204095(v=exchg.140).aspx

Exchange Server - A mail server, calendaring software and contact manager developed by Microsoft. Export -
Copying information from an offline mailbox so it can be stored in a pst file or on the live Exchange Server.

GMT - Greenwich Mean Time (GMT) is considered as a reference point for time.
Host - Domain name of the machine with Client Access role of Exchange Server, or IP address.

Injection - The process of copying data from offline mailbox to live or original connected mailbox on the
server. Local time - Local time is calculated by adding or subtracting a number of hours, depending on a time
zone, to UTC.

Live Exchange Server mailbox - Destination Exchange server mailbox, that exists on the server and is available
for connection. Synonym: attached mailbox.

Mail Store - A type of self-storage whereby customers send items by mail or delivery service (usually by the
box) to be stored at a central location. Synonyms: mailbox, offline database, Outlook storage, database
storage(depending on the conext).

Original mailbox - A mailbox in live Exchange Server that corresponds to the mailbox in the opened database.

OST - An Offline Storage Table (.ost) format. OST is used by Microsoft Exchange Server that enables users to
work with their messages and mail data even when access to the mail server isn't available.
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PST - A Personal Storage File (.pst) format, used to store copies of messages, calendar events, and other items.
PST files are readable with Outlook or other compatible email client.

Unicode PST format - A PST-file format used in Outlook 2003, Outlook 2007, Outlook 2010 and Outlook

2013, so older versions of Outlook will not be able to open Unicode formatted PST files. Previous versions of
Outlook were using ANSI format. The main reason for this change was to allow for international character
support and to extend the maximum size of PST files beyond the 2GB limit of the ANSI formatted PST files. UTC
- Coordinated Universal Time (UTC) is the primary time standard by which the world regulates clocks and time.
Usually used with references to time zones.
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8 Carbonite Server Backup Support

If you have a question about Carbonite Server Backup that isn’t covered in this guide, our frequently-updated
Knowledge Base contains comprehensive information. The Knowledge Base is your first stop when searching
for any Carbonite Server Backup solutions you may need. We highly recommend searching here first for the
quickest answers to your questions.

Knowledge Base: http://support.carbonite.com/evault

What can we help you with?

‘ type a topic or question... m

Popular Searches
pending reboot, restore, cint-e-04103

8.1 Contacting Carbonite

If you need live assistance from a qualified support agent, Carbonite Support is here for you 24 hours a day, 7
days a week (excluding US holidays). Please feel free to get in touch with us, and we’ll help out any way we
can! You can find the contact information for Carbonite Support in the Knowledge Base:
http://support.carbonite.com/evault

CREATE A CHAT WITH A ‘. CALL A SUPPORT

REPRESENTATIVE

SUPPORT CASE , REPRESENTATIVE

Tip: When contacting Support with a technical issue, please have both the program's log files and the store you
are having difficulty with ready.

To gather log files, click File menu and choose Open log folder. Compress the contents of the folder in a .zip file
and attach it to your support request.

If the log archive and/or mail store exceeds 10MB, you may not be able to send them as an email attachment.
In that case, upload instructions will be provided to you upon request.
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